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VI-Suite v0.7 1 Introduction

1 Introduction

The VI-Suite is a free and open-source add-on to the 3D modelling and animation package Blender, that provides
a set of tools for the analysis of environmental factors within and around buildings. It uses Blender’s node system
(figure 1) to provide a user interface that allows quick and custom analyses to be created. As of VI-Suite version
0.7, nodes exist for GIS height map import, sun path analysis, wind rose display, shadow and sky view factor
studies, embodied carbon, lighting metric prediction, energy performance with advanced airflow network creation,
whole-life carbon and flow analysis with computational fluid dynamics. The lighting, energy and flow analyses
are achieved with the three main VI-Suite components: LiVi, which acts as a pre/post-processor for the Radiance
lighting simulation suite (version 5.2); EnVi, which does the same for the EnergyPlus thermal simulation engine
(version 22.1); FloVi, which interfaces with the OpenFOAM CFD suite (version 10).
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Figure 1: Blender nodes

2 Installation

The VI-Suite is an add-on for Blender and can be downloaded from the VI-Suite blog site (https://blogs.brighton.ac.uk/vi-
suite/download/). The zip files available there contain all the Radiance and EnergyPlus files required to run analyses
with the VI-Suite. OpenFOAM binaries are however not included, and must be installed independently by the user.

On Linux, these binaries can usually be installed by the OS’s package management system. Version 10 of Open-
FOAM provided by OpenFOAM.org (https://openfoam.org/) is required. On OS X and Windows, Docker Desktop
should be installed and a Docker installation of the dicehub/openfoam:10 image is required. Docker must be run-
ning in the background when doing a FloVi analysis. The image below shows shows Docker desktop running with

the required Docker image.
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Figure 2: Docker desktop running with dicehub/openfoam:10

VI-Suite v0.7 is compatible with the latest LTS release of Blender (currently 3.6) and version 4.0. The down-
load page of the VI-Suite blog (https://blogs.brighton.ac.uk/visuite/download/) has links to the relevant downloads.
For Windows and OS X, Blender can be downloaded from https://www.blender.org/download/lts/. On Linux, the
system’s package manager should be used to install Blender along with PyQt6, Matplotlib, Kivi and Netgen, as the
zip file from Blender.org will not work with FloVi. Once Blender has been installed, run Blender and go to the
’Edit’ - *Preferences’ menu and in the preferences window (figure 3) click in the *Add-ons’ tab on the left and then
’Install’ at the top. Navigate to the downloaded zip file, select it and the VI-Suite option should appear in the list of
add-ons. Click on the little box on the left to activate the VI-Suite. This step can take some time, and will require
an internet connection, as the VI-Suite downloads and installs required Python libraries.

Once activated, the drop-down arrow to the left of the activation box displays a section for the setting of some
overall options. These are:

(¢]

Radiance bin - sets a custom directory for Radiance binaries. This is not required as the necessary Radiance
binaries are included with the VI-Suite but this option can provide the full suite of Radiance binaries if
desired.

Radiance lib - sets a custom directory for Radiance libraries. This is not required as the necessary Radiance
libraries are included with the VI-Suite but this option can provide the full suite of Radiance libraries if
desired.

EnergyPlus bin - sets a custom directory for EnergyPlus. This is not required as the necessary EnergyPlus
binaries are included with the VI-Suite but for advanced analysis with EnergyPlus’ EMS this should to point
to a complete local install of EnergyPlus to make available the required Python libraries.

EnergyPlus weather - sets the directory for EnergyPlus EPW weather files. This is not strictly necessary as
the VI-Suite comes with a couple of included EPW files but the user will generally want to set this to simulate
with their own climate files.

Database - sets the directory for user databases of materials. constructions, embodied carbon and PV modules.
This should be set to prevent VI-Suite updates overwriting the built-in databases and any user made additions
to them.
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3 Configuration

Running Blender launches the main Blender interface, which should look similar to the one shown in figure 4. The
main interface area is the 3D viewport where the default cube, lamp and camera can be seen. Below this is the
animation timeline, on the top right is the project outliner that contains a list of everything in the scene, and bottom
right are the properties panels where many of Blender’s options and functions reside. At the side of the properties
panel window are tabs to control which panel is visible. The main panels used in the VI-Suite are the "Material"
and "Object" properties panels. Detailed instructions on how to use Blender are beyond the scope of this document,
but there are excellent and free beginners tutorials available online.
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Figure 4: Blender interface

Once the VI-Suite has been activated it creates VI-Suite specific Object and Material properties panels as well
as three node editor windows: “VI-Suite Nodes”, “EnVi Network” and “EnVi Material”. Blender’s interface areas
generally sit side-by-side and any window area can be turned into any other window area type by selecting the type
from the drop-down menu at the left-hand side of an area’s header bar, which sits either at the bottom or the top of
each interface area. For example, the timeline can be turned into the VI-Suite Nodes editor by selecting “VI-Suite
Nodes” in the drop-down menu at the very left of the timeline header (figure 4).
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4 The VI-Suite Interface

4.1 Changes from v0.6

If you are familiar with the interface of v0.6 there are no significant changes to the VI-Suite UI elements. The VI-
Suite controls Blender object properties in the object properties panel (section 4.10.1), Blender material properties in
the material properties panel (section 4.10.2), and 3D visualisation in the 3D Viewport sidebar (section 4.10.3). The
bulk of the VI-Suite UI is however contained in nodes that the user can manipulate within the three VI-Suite specific
node editor windows: “VI-Suite Nodes” (section 4.9.1), “EnVi Network” (section 4.9.3) and “EnVi Material”
(section 4.9.2).

4.2 Kivy Windows

The VI-Suite uses Kivy (https://kivy.org/) to present feedback on running simulations to the user. Any simulation
that takes a noticeable amount of time (SVF, shadow mapping, LiVi, EnVi and FloVi simulations) will open a
Kivy window which will display time to simulation completion (SVF, shadow mapping, LiVi and EnVi), and error
residuals (FloVi). All Kivy windows also present a cancel button to terminate a running simulation.

4.3 Tooltips

Most node and UI options created by the VI-Suite have tooltips. These can be enabled in Blender by going to *Edit
> Preferences > Interface, and turning on Python Tooltips. Hovering over the option in the Blender interface with
the mouse will now offer a small text description of the option.

4.4 Mesh indices

It can be useful to visualise the indices of mesh elements within a Blender mesh object, especially for EnVi analysis
where face index is used to identify the connection of boundary faces across different objects. To turn mesh index
visualisation on go to "Edit > Preferences > Interface’ and turn on “Developer Extras”. Mesh indices can now be
visualised in object edit mode by turning on “Indices” in the viewport Overlays panel. To view face indices, face
select mode must be active and the desired faces selected.

4.5 Collections

Collections are used in Blender 3.6 to organise geometry, which can be viewed and manipulated in the Outliner
window (figure 4). This presents some opportunities for the VI-Suite but also some additional complexity. Collec-
tions are created automatically in the VI-Suite to organise generated geometry e.g. the “LiVi Results” collection
stores LiVi results geometry, “SunPath” stores VI-Suite sun paths etc.

When a user creates new geometry it will automatically go into the current active collection, and this can cause
problems if geometry is created into one of these VI-Suite defined collections, as these collections are sometimes
cleared out to make room for new VI-Suite objects when exporting or simulating. To avoid this make sure that,
in general, user geometry is not resident in these VI-Suite collections when VI-Suite analyses are undertaken.
Manipulation of the location of objects relative to collections can be quickly achieved within the Outliner window

(4).

4.6 File structure

The VI-Suite requires a folder location on the host computer to store files generated during analyses. This folder
is generated automatically when relevant analyses are conducted, and is given the same name as the Blender file,
and in the same location. For example, if the current Blender file is called “First_project.blend” and is saved to
the Desktop, then when required a folder will be created on the Desktop called “First_project”. In the remainder
of this document this folder is referred to as the project directory. Before any analysis can be conducted with the
VI-Suite, the Blender file should be saved to identify the name and location for this project directory.

Dr Ryan Southall 8 School of Architecture, Technology & Engineering
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4.7 VI-Suite log file

As simulation steps are conducted, relevant information is written out to the “vi-suite-log” file in Blender’s text
editor. Information written here will include the commands being run, some results data and error messages. If
something is not working as expected checking this log file is the first step to debugging. Running Blender from a
terminal can also provide additional debugging data.

4.8 Parametric analysis with Blender frames

As Blender is in part an animation suite, it incorporates the concept of animation frames and most elements con-
tained within a Blender scene e.g. geometry, materiality etc., can be animated i.e. their properties can be set to
change across animation frames. The VI-Suite uses this concept of frames to provide parametric analysis, and
refers to the parametric scenarios simulated also as frames.

4.9 The Node System

As the VI-Suite generally presents a node based interface to the user, node editor windows are required to host the
node trees. Three types of node editor window are created as part of the VI-Suite, and can be selected from the
drop-down menu on the left of each Blender area’s header bar. These three node editors are: “VI-Suite Nodes”, to
provide overall control of VI-Suite simulations; “EnVi Network” nodes to provide the interconnections between
zones and zone properties for EnVi simulations; “EnVi Material” nodes to designate construction layers in EnVi
Simulations.

Within each of these node editor windows there is a tab (figure 5) in the right hand sidebar (’n’ key toggles
visibility) that allows you to switch between different node editors and node trees.

Nodes and the relationship between nodes, called node trees, are created by the user, or automatically by the
VI-Suite, in these node editor windows. VI-Suite nodes can sometimes be coloured red and this generally means
one of three things:

o The node contains a button which has not yet been pressed but needs to be.
o The options selected within the node are different to the selected options when the button was last pressed.

o The options selected within the node are invalid within the context of the other nodes the node is connected
to.
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=] Envi Network =
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S v EnViMaterials -
i
Time-staps/hol 1 J atticfloor
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Figure 5: VI-Suite nodes menu on the right to switch between all VI-Suite node trees

Dr Ryan Southall 9 School of Architecture, Technology & Engineering



=
VI-Suite v0.7 @ﬂ 4 The VI-Suite Interface

The node colour will revert to the general Blender theme colour if none of the above conditions are true and
the node, in its current state, is valid as a simulation component.

Links between nodes are also generally controlled by the VI-Suite so that only valid links can be made. If a
link is attempted between two node sockets that are incompatible, the link will immediately disappear. Sockets are
generally coloured to show which can be connected (red to red, yellow to yellow etc).

4.9.1 VI-Suite Nodes

Nodes created within a VI-Suite Nodes window specify the the main building blocks to create simulations. An
initial VI-Suite Node tree has to be created manually by clicking on the “New” button in the middle of the header
bar of the VI-Suite Nodes interface area. Only one VI-Suite node tree should be created. Once a node tree has been
created nodes can be added with the “Add” menu in the node window header bar. There are six node categories:

o “Input nodes” that import data into the VI-Suite

o “Process nodes” that export Blender information to a format that can be used for analysis
o “Analysis nodes” that run analyses

o “Display nodes” that display the results of analyses.

o “Image nodes” that process images.

o “Edit nodes” that can manipulate data

o “Output nodes” that can export data for third-party analysis.

View Select Add Node 29| NodeTree Ol x| £
¥ VI-Suite E
e | Node tree creation D o =
- d selecti £
Tronsience: T EEEEEEEE and selection e :
Turbulence: k-Epsion ) =
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vty FEET =
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RIS Qpefpkatins
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NutVaoe: C_ ) { Cosein
Tvalue: K 293.14
Radiation:
ki
e
Solar:
sun:
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U Reseuat
We/oResiduat
Export

Figure 6: VI-Suite Nodes editor

If switching a window area from a VI-Suite node tree to something else e.g. an animation timeline window, and
then switching back again, the previously active node tree may not display. The user will then need to select the
node tree from the drop down menu in the middle of the VI-Suite Nodes window header bar or from the VI-Suite
node menu (figure 6).

4.9.2 EnVi Material Nodes

If conducting an EnergyPlus simulation with EnVi, building construction specifications are required. These are
created with EnVi Material nodes. An EnVi Material node tree is created by clicking on the “Create EnVi Nodes”
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button in Blender’s material properties panel. This node tree is linked to the Blender material for which it was
created, so selecting the material will show the linked node tree in the EnVi Material interface area. An EnVi
Material node tree can also be can also be selected by clicking on the EnVi material in the VI-Suite node menu in
the sidebar of any VI-Suite related node window (figure 5).

In the “Add” menu of an EnVi Material node tree are the following categories:

o Type node - Type of construction (currently just EnVi Construction)

o Layer node - Type of material: opaque, transparent and gas (latter two are mainly for window constructions)

[¢]

Shading node - Shading layer, blind layer, screen layer, switchable layer, shading control node (experimental
nodes for advanced shading)

o Schedule node - sets an EnergyPlus schedule

o PV node - Photovoltaic and Photovoltaic generator nodes
When creating an EnVi Material node tree with the “Create EnVi Nodes” button in the material panel a single node
is created by default: an EnVi Construction node.
4.9.3 EnVi Network nodes

Nodes created within an EnVi Network node editor window control the zones and the relationship between zones
for EnVi simulations. An EnVi Network node tree is created automatically when exporting Blender geometry with
an EnVi Geometry (section 31) node, and an EnVi Zone node is created here for each thermal zone to be simulated.
A single EnVi AFN node (section 34) is also created here.

In the “Add” menu of an “EnVi Material” node tree are the following categories:

o Zone nodes - defines EnergyPlus zone and associated parameters
o Schedule nodes - defines EnergyPlus schedules

Airflow nodes - defines airflow connections between zones and external air conditions

[¢]

o EMS nodes - defines ERL program elements for runtime control of EnergyPlus simulations.

An EnVi Network node tree is created automatically when a valid EnVi geometry export is conducted within the
VI-Suite Nodes tree, and should not be created by the user.

4.10 VI-Suite panels

In addition to node editor windows, the VI-Suite creates some panels for the specification of VI-Suite specific
object and material properties.

4.10.1 Object properties panel

The object properties panel is one of the properties pan-
els situated by default in the lower right of the Blender

. . . . i v VI-Suite Object
interface (figure 4). The object properties panel defines

Blender properties at the object level. Within this panel ((None )

there is a sub-panel called “VI-Suite Object” where ~ Octree generation --

the nature of the object is defined in terms of the VI- Triangulate: O

Suite. Mesh:
If the currently selected Blender object is a mesh [ Generate Octree )

then the first menu presented defines the VI-Suite type. Smiodled: O

T tions include:
ype options Inciice Figure 7: VI-Suite Object definition tab
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o

None - there is no object level specification required. This applies for general lighting simulations, and
shadowing where only the geometric object data is required, and VI-Suite specific properties are instead set
at the material level. As this option generally applies to lighting geometry some LiVi specifc options are
presented:

o Octree generation - generates a Radiance octree for instancing

* Triangulate - triangulates the mesh before octree generation. This can clean up the resulting octree
in cases where there are non-planar quads or n-gons.

* Fallback - generates the octree from a simple face description rather than a Radiance mesh. This
must be turned off if the octree is to have textures or smoothing applied.

EnVi Surface - the object represents a collection of EnergyPlus constructions.
CFD Domain - the mesh object represents a computational domain for OpenFOAM analysis with FloVi.

CFD Geometry - the mesh object represents an obstruction within a domain for OpenFOAM analysis with
FloVi.

Light Array - mesh the object represents an array of artificial lights, via its mesh sub-division, for lighting
analysis.

¢ Subsequent options allow for the selection of an IES file that defines the artificial lighting as well as
the dimensions within the IES file, its strength and colour.

Complex Fenestration - the object represents an element of a repeating geometric array for which a lighting
BSDF is to be generated.
o Direction - defines the direction of the BSDF calculation.
© Proxy - whether to incorporate the geometry into the BSDF for direct light calculations.
* Length unit - converts Blender units to the selected unit for proxied geometry.
¢ Klem/Tensor - selects the type of BSDF angular subdivision
¢ Samples - how many samples per sub-division are to be used for the BSDF calculation.

o RC Params - A text box for custom Radiance rcontrib parameters.

CFD Probe - the mesh object represents a region within the FloVi domain to measure flow rate.

If the object is a Blender “Light” then the following options are presented:

(e}

(e]

IES file - file opening dialogue to select an IES file Select

IES dimension - sets the distance unit for any embedded geometry
IES strength - a multiplier which allows the light output to be dimmed
IES colour - menu to the colour type.

¢ RGB - uses RGB colour description
* [ES RGB - sets the RGB colour
o Temperature - uses a colour temperature description

* IES Temperatuire - sets the colour temperature in Kelvin

If the object is a Blender “Empty”, a single option “CFD probe” is presented which defines this empty as an Open-
FOAM probe during a FloVi simulation.

4.10.2 Material properties panel
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In the material properties panel, VI-Suite properties are
defined at the Blender material level. For the currently
selected Blender object and currently selected Blender Material type [ Geometry v]
material (selectable at the top of the material properties
panel), a sub-panel called ’VI-Suite Material’ will be
presented. The first option in this sub-panel, the “Ma- Material Reflectance: [
terial type” drop-down menu has three options:

Vv VI-Suite Material

LiVi Radiance type: [ Plastic v]

[ Roughness 0.10 }[ Specularity 0.00

o Geometry - for standard geometry suitable for Textured:
lighting/radiation and energy analysis. Dirt noise: O
o Light Sensor - for a material that controls where Texture image: [m ]
lighting metrics are calculated and stored.
Normal map: [IA_‘J ]
o FloVi boundary - that sets boundary conditions Blend mask: [ N ]
for CFD simulations.
If Geometry is selected the following options are spe- [ Create EnVi Nodes J

cific to creating a Radiance material description for
analysis with LiVi, and are redundant if doing a shadow

mapping (section 5.3) or SVF calculation (section 5.4): Figure 8: VI-Suite Material tab

o LiVi Radiance type - defines the type of Radiance material and presents relevant material parameters for that
Radiance material type.

o If the LiVi Radiance type is glass, dielectric, anti-matter or translucent the following additional option is
presented

¢ Photon port - specifies this material as a photon port for photon mapping calculations (the normal of
any associated mesh faces should point towards the camera or sensor geometry)

o If the LiVi Radiance type is glass, the following additional option is exposed:

¢ Trans type - selects whether RGB transmission colours are used from the transmission option, or win-
dow transmittance value is used from the transmittance option.

o If the LiVi Radiance type is not anti-matter, BSDF, custom or light then the following additional options are
presented:

¢ Textured - signifies the material as a textured material, which will cause LiVi to export the associated
geometry as a Radiance mesh, even if the mesh option in the LiVi Geometry node is turned off. It also
exposes the following options.

¢ Dirt noise - activates a Radiance ’dirty’ noise pattern to be applied as a modifier to the material
* Dirt spacing - selects how dense the dirt pattern is
* Dirt level - sets how strong the dirt pattern is

¢ Texture image - a Blender image to be mapped to this material in Radiance (image should be UV to
geometry mapped in Blender).

© Normal map - a Blender image to act as normal perturbation for the Radiance material (image should
either be UV mapped in Blender or the UV mapping from the Texture image can be used)

* Strength - strength of the normal map perturbation
* Vectors for the green and red components of the normal map in Blender world coordinates when
applied to the mesh face

¢ Blend mask - a black and white image to act as a Radiance material mixer. White pixels expose the
current material, black exposes a background material (image should either be UV mapped in Blender
or the UV mapping from the Texture image can be used).
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* Background material - material to be exposed according to black pixels in the blend mask image.
o If LiVi Radiance type is BSDF the following options are presented:

¢ Proxy depth - the depth of the proxy geometry in metres
s Up vector - the vector in Blender world space that defines the up direction for the BSDF
* Load/Save/Delete BSDF - option to load/save/delete a pre-existing BSDF description.

o Create EnVi Nodes - button to create an EnVi Material node tree associated with this material
If the material type is set to Light Sensor:

o Presents the same options as for the Geometry option.
If the material type is set to FloVi boundary, boundary conditions for a FloVi simulation can be set:

o NetGen max cell size - sets the maximum NetGen cell size on the edges and vertices of geometry associated
with this material

o Further options here are FloVi context specific and are detailed in section 5.8.2

4.10.3 Visualisation panel

Control of the visualisation of results within Blender’s 3D view is done within 3D Viewport sidebar, which can be
opened and closed with the ’n’ key while the mouse is over the viewport. Within the sidebar there is a tab called “VI-
Suite” (figure 9), which after a simulation will contain a button to enable visualisation. After pressing this button
the panel will get populated with visualisation options. As the options presented in the panel are context specific,
their details are discussed in the relevant analyses sections. The example in figure 9 shows sun path visualisation
options.

, ¥ VIDisplay
| Lighting: | Flat

@ %
[

II

Vi-Suite || PDT || Laser || Techsec || view || Tool || 1tem

Latitude: 5115
Longitude:

Day of year: 2013
Time of day: 13:49 1383

B &

mDDIHHHHEHIIHIIIH

Sun strength:

Sun angle:

5

= Linewidth:
Solstice colour:
Hour main colour:
““_Hour dash colour:
— Hour dash ratio:
< Hour dash density:
" sunsize:
- Suncolour:
" Globe colour:
. Display time:
Display hours:

-,/ Display active

~

Figure 9: VI-Suite Display tab

VI-Suite v0.7 also has a display framework that will create icons in the 3D viewport for the visualisation of
certain analysis results. The icons will appear, when appropriate, in the upper left of the 3D viewport. If these icons
are clicked a data window will appear. Clicking and dragging on the upper left corner of the data window will move
it around the 3D view and clicking and dragging the bottom right corner of the data window will resize it. The full
list of icons that can be created is presented below although the actual icons created depend on the analysis context.

o = Legend display - this will display a colour bar that relates numerical value to colouration of results
geometry.
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o % Table display - this will display tabulated results.

) e BSDF display - this will display a Klems tree visualisation of a calculated or loaded BSDF.
At the bottom of the "VI-Suite Display" panel is a ’Display active’ toggle. It is good practice to turn this off before
initiating another simulation, when loading another Blender file or when finished with the display of results.
4.10.4 VI Gridify panel

The VI-Suite tab of the 3D viewport sidebar will show a VI Gridify panel when a Blender mesh object is in edit
mode, which will contain a “Grid the object” button. This button will cut a grid pattern into selected mesh faces
and is useful for creating sensor grids within sensor geometry. On pressing the button, the selected faces of the
Blender mesh object will be sliced according to the grid dimensions and rotation options displayed in the operator
panel, which will show up on the bottom left of the 3D viewport. These values can be changed and the grid pattern
will live update. The operator panel options are:

o Rotation - angle of rotation of the grid relative to the face normal
o us - grid up size (making this very small can take a long time)

o acs - grid across size (making this very small can take a long time)
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4.11 Common Nodes

Common nodes are nodes that do not belong to any particular simulation pipeline.

4.11.1 The VI Location node

A VI Location node can be added from the "Add > In-
put nodes > VI Location" menu in the VI-Suite Nodes
window once a valid node tree has been created. The VI
Location node sets the location of the context to be ana-
lysed in terms of latitude and longitude and, if required,
hourly weather data from an EPW format weather file.
This node is a required node for sun-path, solar shad-
ing, SVF, wind rose, EnVi and LiVi analyses.
The options within this node include:

o Source - the source of the location data

© Manual - the user specifies latitude and lon-
gitude positions for the project in decimal
format. Latitude is -90 to 90 degrees south-
pole to north-pole, and latitude is -180
to 180 degrees, with West relative to the
Greenwich meridian being negative. This

( )

v VI Location &)

Location out O

Source: [ Manual v\
Latitude [ 52.00
Longitude [ 0.00

Figure 10: VI Location node

is the same as the latitude/longitude numbers as reported by Google maps/Earth.

o EPW - the latitude and longitude values are red from the selected EPW weather file. This is required for all
climate based analyses such as LiVi climate based simulations, EnVi and wind rose analyses.

© Weather file - a drop-down menu which selects the EPW weather file. Entries in this menu are defined
by the EPW weather file directory setting in the VI-Suite addon preferences. If this preference is not
set, a directory with a couple of sample EPW included within the VI-Suite is referenced. All files with
the extension .epw or .EPW in the referenced directory should appear in this menu.

The VI Location node has one output socket, a light green "Location out" socket, which can connect to any light
green "Location in" socket. If an EPW weather file is selected, the *Location out’ socket can also connect to the
green input socket of the VI Chart node for plotting of the weather data.

4.11.2 The ASC Import node

ASCII formatted Esri Grid files are GIS data files
which can represent ground elevation data in text file
format. These files often have the extension .asc and
are referred to as ASC files here. ASC files can be ex-
ported by the Edina DigiMaps web service that contain
accurate terrain height data for the whole of the UK.

The ASC import node can be added via the "Add
> Input Nodes > ASC Import" menu in the VI-
Suite Nodes node editor once a node tree has been
created. The node contains two toggle options, a
menu and an operator button. The toggle options
are:

o

‘ Zero v

Single file:

No data:

| Import ASC

Figure 11: VI ASC import node
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o Single File - if on, only the ASC file selected is imported. If off, all ASC files within the directory of the
selected ASC file will be imported.

o No data - if height data at a point is missing from the ASC file, this drop down menu mandates what should
happen at that point
© Zero - makes the height zero
¢ Delete - skip importing that point
The “Import ASC” button converts the ASC file into Blender co-ordinates and creates a mesh within the scene

which accurately represents the ground heights in the ASC file. Once this geometry has been imported it can be
subject to further analysis, for example a FloVi CFD analysis (figure 12).

Figure 12: Regions with wind speed above 7m/s (gltf file imported from Paraview)

4.11.3 The VI Chart node

The VI Chart node (figure 13) uses Mat-

plotlib (http://matplotlib.org/) to provide

simple line plotting for certain types of data.

The node has one input socket called “Res-

ults in” which can link to any node output | Vitocaton ©
socket called “Results out”, and the “Loc- ocston ot
ation out” socket of the VI Location node :::::;,me:
which uses an EPW file as source data. Ini-
tially only the X-axis socket is exposed. Figure 13: VI Chart node

Once this socket is connected, a "Y-axis 1"

socket is exposed. Once this socket is con-

nected, a "Y-axis 2" socket is exposed. In total three "Y-axis" sockets can be exposed. It is possible to connect

v VI Chart

: Start/End Day: 1/131/12 _Start 1) (End 365 )

| Chart type: (_Line/scatter vJ ( Hourly V) (op 92

1 ( Create plot )|

O xaxis: [0 V) (Time v
O Y-axi...[ 0 ) ((climate ) (Humidity %) v} [ 100 ]
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different result source nodes to the input sockets of this node but the result length coming from each source node
must be the same for a valid plot.

Next to each connected socket, menu items will appear to select the type of data to plot on the axis. This
contents of these menu items depends on the contents of the results embedded in the connected node. Generally
the first menu is the frame (section 4.8) of a simulation to be plotted, the next is the class of result e.g. Climate
or Zone temporal, the next is the result location e.g. Exterior or zone name and the next is the actual result. A
multiplification factor option is also exposed at the end to scale the results on a particular axis.

The options presented by the node are:

o X range or day range - the range of the data currently plugged into and selected to the X-axis input socket

o Start - choose the start of the X range to be plotted
< End - choose the end of the X range to be plotted

o Chart type - Line/Scatter for line (only line is currently supported)

o Frequency - a drop-down menu to select hourly, daily, monthly results plotting. Only visible if the X-axis
data is time.

o DPI - the DPI of the resulting graph

A "Create plot" button in the middle of the node creates the Matplotlib plot in a new window. Buttons within
this new window allow some manipulation of the chart, associated texts, and export to image file (see Matplotlib
documentation for more details).

4.11.4 The VI Heatmap node

The VI Heatmap node creates a heatmap image based
on temporal, or time based data, such as that produced
by an EnVi or LiVi CBDM analysis or the climate data

v VI Heatmap

ina VI Location node. This node replaces the 3D View- (o ~] (_opi 92 |
port heatmap function from previous versions. Options [ Climate v] [ Exterior v] [ Diffuse So... v]
within this node include:

Days: ( 1 J [ 365 )

o Frame menu - this selects the frame of the ana- Hours: [ 2 ] [ > ]
lysis to be visualised - important in parametric

analyses where multiple frames are simulated. Metric range: [ Custom v]

o DPI - sets the size of the matplotlib window Range: { 0 J_4s0 |

opened. Colour map: [ Viridis v]

o The next three options define the result from the Cantour lines: U
attached node to be visualised: the first option Contour fill:
sets the res.ult class, thg second represents the Grid display: O
result location and the third represents the actual
result. Contour levels: [ 9 ]

Create heatma
o Days - sets the day range for the heatmap [ P ]
Q) VI results
o Hours - sets the hour range for the heatmap
o Metric range - sets the range of the result to be Figure 14: VI Heatmap node

plotted as a heatmap:

© Auto - plots out the minimum to the maximum of the result

¢ Custom - allow the setting of the lower and upper range for plotting
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o Colour map - selects the colormap for the plot

o Contour lines - Turns on contour line overlay

¢ Line width - sets the line width of the contour lines

o Contour values - space separated numbers to define contour line values and labels (a lone space here

produces contour lines but no labels)

o Contour fill - sets a filled contour

o Grid display - sets a grid overlay on the contour fill

o Contour levels - sets the number of contour levels for line and fill display

Days

- = N N w w H ey

o w o w o w o w

o o o o o o o o
Diffuse Solar (W/m~2)

w
o

o

Figure 15: Example heatmap (diffuse solar)

4.11.5 The VI CSV Export node

The VI CSV Export node can be added to a VI-Suite
Nodes node tree with the “Add Output Nodes > CSV”
menu. The node has one input socket “VT results” for
connection to a “Results out” output socket, or a “Loc-
ation out” socket if the associated VI Location nodes
uses an EPW file as source data, and converts them to
CSV format. The CSV formatted data can then saved
to a file for third-party visualisation/processing. If the
results from the simulation contains parametric data the
node will expose one “Animated” option which toggles
whether only the animated parametric data or the com-
plete static data set is exported. The “Export CSV file”
button will open up a file save window and the name
and the destination of the CSV file can be specified.

V VI CSV Export =

[ Export CSV file ]

VI results

Figure 16: VI CSV Export node
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4.11.6 The Text Edit Node

The *Text Edit’ node in the ’Edit Nodes’ menu allows for

an information pipeline to be interrupted for manual editing r - N
within Blender’s text editor. This node currently only works Vv VI Text Edit E
with the LiVi simulation pipeline. Once a LiVi Geometry or
Context node is connected to the *Text in’ socket the Radi- Text out ©
ance input text is loaded into Blender’s text editor. The name
of the text file within the text editor is also shown within the Text name: LiVi Geometry
node. If any changes are made to the text in the text editor
an ’Update’ button appears within the node. When pressed (8 Text in

the updated text is loaded into the node and will be presen-

ted to any ’LiVi Simulation’ node connected to the *Text out’

output socket. Figure 17: VI Chart node

4.11.7 The VI Metrics node

The VI Metrics node can benchmark simulation results based
on particular environmental standards. The VI Metrics node

: o v VI Metrics g
can also present results from probes embedded in FloVi sim- L
ulations. The node has a single “VI results” socket input that Vl results €
connects to the “Results out” socket of Embodied Carbon,
LiVi, EnVi and FloVi simulation nodes. Once a valid socket Type: Energy v
connection has been made then and a valid type has been se- Metric: [ SAP v]
lected, metric values will appear at the bottom of the node,
which comparisons to the chosen standard. There are also Frame: [ 18 VJ
ce.rt_aln 51mul¢::1t10ns where an infographic can be created de- Zone: [ Al "J
tailing compliance with the relevant standard or encapsulat-
ing alevel of performance. If this option is available, a button (‘B VI results
will appear at the bottom of the node and will display either
a matplotlib window or a new Blender image editor window Figure 18: The VI Metrics node

with an infographic image.
Options within this node include:

o Type - sets the metric type:

¢ Lighting
* RIBA 2030 - displays average daylight factor and uniformity ratio in comparison to the require-
ments of RIBA 2030 Climate Challenge for LiVi Basic simulations

* BREEAM - displays average and minimum daylight factor, uniformity ratio complaint floor area
and BREEAM credits for LiVi Basic simulations

* LEED -displays sDA and ASE results in comparison to LEED v4 option 1 daylighting requirements
for LiVi CBDM simulations
¢ Energy

* SAP- generates a SAP score and EPC rating for EnVi simulations

- Heating type - sets the fuel type for the heating system (for gas set the conversion efficiency
of the gas heating system, for electric set the COP for heating and hot water provision)

- Unregulated - level of unregulated energy consumption (kWh/m?)

# RIBA 2030 - displays kWh/m?results in comparison to the requirements of RIBA 2030 Climate
Challenge for EnVi simulations

- Heating type - sets the fuel type for the heating system (for gas set the conversion efficiency
of the gas heating system, for electric set the COP for heating and hot water provision)

- Unregulated - level of unregulated energy consumption including hot water (kWh/m?)
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- Type - type of building

# PassivHaus - compares space heating in kWh/m? to the PassivHaus standard

¢ Flow - prints out pressure, speed and wind pressure coefficients for the selected probe

* Reference type - type of reference pressure point for WPC calculations

- Probe - reference pressure is chosen from the chosen pressure probe point
- Manual - reference pressure is manually inputted by the user

o

lations.

<&

<

Embodied carbon - calculates the embodied carbon for stand-alone and EnVi embodied carbon simu-

Comfort - calculates overheating risk in comparison to RIBA 2030 requirements

IAQ - calculates internal COslevels in comparison to RIBA 2030 requirements

o WLC - calculates whole-life carbon results for EnVi simulations

* Heating type - sets the fuel type for the heating system (for gas set the conversion efficiency of the

gas heating system, for electric set the COP for heating and hot water provision)

+ Unregulated - level of unregulated energy consumption, excluding hot water (kWh/m?)

+ Hot water - level of hot water energy consumption kWh/m?2-yr
* Carbon factor - carbon factor for local grid electricity (kgCO2/kWh)

* Annual change - annual change in carbon factor (%) associated with the local electrical grid

o Frame - sets the animation frame if looking at parametric results

o Zone - sets the zone name for comparison, based on the Blender object, collection or probe name if conducting

a lighting, energy or flow comparison respectively.

4.12 Specific Analysis Nodes

Analysis nodes can be found in the "Add > Analysis nodes" menu in the VI-Suite node tree. Analysis nodes initiate
actual calculations. Some analysis nodes need to be part of a larger node set-up, for example LiVi and EnVi
simulation nodes, whereas others represent a complete analysis, for example wind rose and shadow study nodes.
These standalone analysis nodes are described here.

4.12.1 The VI Wind Rose node

The VI Wind Rose node takes wind data from an EPW
weather file and creates a wind rose plot within the 3D view-
port. The VI Wind Rose node has one input "Location in"
socket that connects to a VI Location node "Location out"
socket. As EPW data is required, EPW must be selected as a
source of information in the VI Location node. Once a valid
"Location in" socket connection has been made the following

options are made available:

o Type - sets the type of plot (two types of histogram and
three types of contour are available)

o Temperature - flag to plot ambient temperature against
wind direction instead of speed.

o Start day - sets the first day of the year for the plot

o End day - sets the last day of the year for the plot

o Colour - sets the colouration of the plot

Vv VI Wind Rose
Type: Cont1l
Temperature:

Start day 1/1:

IIOIJ[&

End day 31/12: 365
Colour: CMR v

Max frequency: Data

I

[ Create Wind Rose

N

(B Location in

Figure 19: VI Wind Rose node
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o Max frequency - sets the maximum frequency for the
plot:

¢ Data - maximum frequency is set to the data maximum frequencies

o Specified - maximum frequency is set to a user specified maximum frequency

Upon pressing the "Create Wind Rose" button a new wind rose object is created within the Blender scene which can
be scaled, moved or rotated as desired. This wind rose object will be placed in the WindRoses Blender collection.
Wind rose specific display options are also revealed in the VI Display panel (section 4.10.3).

4.12.2 The VI Sun Path node

The "VI Sun Path" node shown in figure 20 creates an object within

the Blender scene for sun path visualisation (section 5.1). As the sun ~ VI Sun Path # )
path analysis requires latitude and longitude data this node has one input
socket "Location in" which connects to a VI Location node’s "Location S
out" socket. The VI Location node can use either manual or EPW latitude
and longitude specification. The node contains one menu that defines the [ Create Sun Path ]
suns created:
Location in
o Single - single sun for a single point in time. J
o Hourly - a sun is created for each hour of a particular day if it is Figure 20: VI Sun Path node

above the horizon

o Monthly - a sun is created for each month at a particular time if it
is above the horizon.

Once a valid "Location in" socket connection has been made a button is exposed to create the sun path, which will
be placed in the Blender SunPath collection. Once the sun path object is created, options appear in the VI-Suite
Display panel (section 4.10.3) to control the day, time and size of the sun path objects for real time visualisation of
sun position.

4.12.3 Sky View Factor node

The VI SVF node (figure 21) generates a sky view factor (SVF)
analysis. The SVF results are plotted on sensing geometry given

a Light sensor VI-Suite material. SVF is the proportion of the Y VISVE Z
sky that can be seen from each sensor point and can be use- Vl results ©
ful for the study of urban contexts. The VI SVF node is a

stand-alone node is it needs no other nodes in order to conduct Ignore sensor: UJ
a calculation. The node contains one output socket: a ’Res- AalirErieme
ults out’ socket to send the results to a VI Chart or VI CSV

node for additional processing. Any exported CSV file will Sky patches:
contain the x, y, z position of the sensing points and the sky Result point:
view value at those points. The node also contains one op-

erator button to conduct the calculation. Once a calculation Gl
has been conducted a ’Sky View Display’ button will appear [ Sky View Factor J

in the 3D Viewport sidebar VI-Suite Display panel and result
geometry will be written to the LiVi Results Blender collec- .
tion. Figure 21: VI SVF node

Options within the node are:

o Ignore sensor - turning this on will exclude the sensing geometry from the sky view calculation. This should
be turned on when conducting analysis on fictitious or arbitrary planes, and turned off for physical sensing
geometry such as terrain.
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o Sky patches - this controls the resolution of the sky patches for the view factor analysis (figure 22)

o Result point - to specify whether the sky view sensing points are positioned at the face centre or vertices of
the sensing object

o Offset - to specify the distance of the sensing point from the geometry (this is useful if the sensing mesh has
non-planar faces that would place the centre of the face below the face surface). If results are inexplicably

zero for some result points, try increasing this number.

9,

»
caReed

Seescos

Figure 22: Sky View Patches (Tregenza, Reinhart 577, Reinhart 2305)

4.12.4 The VI Shadow Map node

The VI Shadow Map node (figure 23) colours sensing geometry
(specified by applying a Light sensor VI-Suite material to geo-
metry) based on the proportion of time the geometry is exposed
to direct sunshine, assuming clear sky conditions. The calcula-
tion is done every specified interval during month and hour range
specified if the sun is above the horizon. The node has one in-
put socket; "Location in" which connects to a VI Location node’s
"Location out" socket. The VI Location node can have either
manual or EPW specified latitude and longitude. The node also has
a “Results out” socket for connection to a VI Chart or VI Heatmap
node for plotting, or a VI CSV node for exporting the calculated

v VI Shadow Map

Ignore sensor:
Animation:
Start day 1/1:
End day 31/12:

S

1

VI results €

Static

3

)]
(8]

=X~ =
< < O

data to a CSV formatted text file. Start hour:
Node options, which are only displayed once a valid socket End hour: 2
connection has been made, include:
Hour steps:
o Ignore sensor - when tl'lrned on shading sensor surfaces do Result point: Faces
not shadow other shading sensor surfaces.
Offset: 0.01
o Animation - to specify whether geometry is animated or
. [ Calculate ]
static.
. . . (8 Location in
¢ Static - no parametric analysis

o Geometry - a geometry based parametric analysis

* Frames - the start and end frame for the parametric
analysis

o Start & end day - to specify the day range for analysis.
o Start & end hour - to specify the daily hour range.

o Hour steps - number of calculation steps per hour.

Figure 23: VI Shadow Study node
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o Result point - to specify whether the shadow sensing points are positioned at the face centre or vertices of

the sensing object

o Offset - to specify the distance of the sensing point from the geometry (this is useful if the sensing mesh has
non-planar faces that would place the centre of the face below the face surface). If the results are inexplicably

zero for some result points try increasing this number.

After simulation options are available on the VI-Suite Display panel for result visualisation within the 3D veiwport.

4.12.5 The VI Embodied Carbon node

The VI Embodied Carbon node (figure 24) allows for a stand-
alone calculation of embodied carbon based on Blender mesh
geometry. The analysis requires Blender objects to have
been given appropriate embodied carbon data. The options
presented within this node are:

o Entities:

© Objects - embodied carbon metrics are calculated
per Blender mesh object

¢ Collections - embodied carbon metrics are calcu-
lated per Blender collection

o Parametric - allows for a parametric run to be simu-
lated based on a frame range:

o Start frame - Start frame for the parametric run

¢ End frame - End frame for the parametric run

o Heal - toggle that will attempt to heal Blender geometry to make it manifold. Non-manifold geometry details

will be written to the vi-suite-log file.

v VI Embodied Carbon <
VI results €

Entities:
Parametric: (]

Heal: B

Floor area:
Timeframe:
[ Calculate J

Figure 24: VI Embodied Carbon node

o Floor area - for kgCOge/m?of floor area calculations this number specifies the floor area in m2.

o Timeframe - the overall time frame over which the embodied carbon calculation is to be conducted (default

is 60 years).

A “VIresults” output socket will be exposed after simulation for connection to a VI Chart, VI CSV or VI Metrics

node.
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4.13 LiViNodes

LiVi nodes control and specify a LiVi simulation for the prediction of lighting metrics.

4.13.1 The LiVi Geometry Export node

The LiVi Geometry node (figure 25) can be added to a VI-Suite
Nodes tree with the Add > Process nodes > LiVi Geometry’ menu
entry and exports Blender geometry and materiality to a format that
can be understood by the Radiance lighting simulation suite. All

v LiVi Geometry :ljl

Geometry out

unhidden lights, geometry (that has the VI-Suite object definition
“Geometry” or “Light sensor”) and materials in the Blender scene Triangulate: D
are exported and the Radiance description stored within the node.
An exception to this is objects or materials with “/”” in the name, Mesh: U
2: et.his is not supported by Radiance. Some geometry options here Animated: D
o Triangulate - will triangulate the mesh before Radiance ex- Result point:
port. This may be useful where the meshes contain weird Offset:
N-gon geometry.
[ Export ]
o Mesh - if disabled, each mesh face is written out individually N o

to Radiance format, unless the object has a textured material
associated with it. If enabled, Radiance meshes are exported
for each Blender object. Mesh export can be slower to simulate but is required for mesh smoothing in
Radiance, which is enabled by turning on object smoothing and creating custom split normals for the object
in Blender.

Figure 25: LiVi Geometry node

o Animated - sets if the geometry or materiality changes for a parametric analysis
¢ Frames - the start and end frame of the parametric analysis
o Result point - specifies of the sensing points are based at the vertices of face centres of the sensing geometry

o Offset - this option is useful for non-planar n-gon or quad surfaces where the average central point of a
face centre is actually below the face surface. If calculated results are inexplicably zero on some faces, try
increasing this value.

The node has one *Geometry out’ output socket that can connect to the *Text in’ socket of a VI Text Edit node or
the ’Geometry in’ socket of a LIVi Simulation or LiVi Image node.

4.13.2 The LiVi Context node

The LiVi Context node (figure 26) controls the export of a lighting simulation context to a text format that Radiance
can understand. In terms of a Radiance simulation, context means the type of sky the building is exposed to, the
time of day and year and the metrics to be calculated. This node can create two different categories of sky context:
“Basic”, for simple lighting metrics, and “CBDM”for climate based daylight modelling.

The node has one input socket and one output socket. The input socket is a "Location in" socket for connection
to a VI Location node’s "Location out" socket (if a LIVi CBDM analysis is required then EPW must be set as a
source of climate data in the VI Location node). Once a valid connection on this socket has been made, options
will appear and an “Export” button will be presented. On pressing this button the sky context is stored within the
node.. The output socket is a "Context out" socket for connection to a “Text in” socket of a VI Text Edit node or
the “Context in” socket of a LiVi Image or LiVi Simulation node.

Dr Ryan Southall 25 School of Architecture, Technology & Engineering



VI-Suite v0.7

4 The VI-Suite Interface

vV LiVi Context

£e3

Context out

!

V LiVi Context

%

£o3
Context out
Context: Parameter
program: Context:
Sk type: Type:
Ground ref: Spectrum:
Ground col: : All year: D
Sun distance: Weekdays only: O
Start hour 12:0: Start day 27/10: 300
Start day 1/1: End day 26/12:
Animation; D Start hour:
Turbidity 275 End hour:
HDR: D Source file:
Split channels: d Resolution:
[ Export ] [ Export ]
([) Location in ([) Location in
(a) LiVi Basic (b) LiVi CBDM

Figure 26: LiVi Context node

Node options are dynamic and presented only if appropriate for the type of analysis selected, which is set with
the first “Context” menu. The “Context” menu options are:

o Basic - for basic lux, W/m? and daylight factor calculations:

¢ Program - sets the sky generator

* Gensky - uses Radiance’s Gensky program to generate the sky

- Sky type - sunny, partly cloudy, cloudy, daylight factor and no skies are supported
- Turbidity - sets the turbidity for the sky

*

Gendaylit - uses Radiance’s Gendaylit program to generate the sky

- Spectrum - choose visible or solar spectrum radiation

- Colour sky - Enables a coloured sky description

- Epsilon - sets the epsilon value for the generated sky

- Delta - sets the delta value for the generated sky

*

HDR Sky - allows the loading of an existing HDR image as a Radiance sky texture

- HDR format - ’Angular’ for angular maps and ’Polar’ for conventional latitude-longitude
format (equirectangular in Blender)

- HDR rotation - environment map centre is south by default, a degrees rotation can be specified

with this option.

- HDR distance - radius of the sphere in metres upon with the Radiance sky texture is mapped

* Radiance Sky - allows the loading of a pre-existing Radiance text file sky description from Blender’s

text editor

* None - no sky (can be useful for artificial lighting calculations)

¢ Ground ref - sets the ground reflectivity

¢ Ground col - sets the ground colour

¢ Sun distance - as this node creates a sun within the Blender scene, positioned relative to the blender
world origin in accordance with the settings within this node, this option sets the distance of the sun

from the world origin.

o Start hour - hour time for sky creation (decimal input, hours and minutes are shown in the option label)

Dr Ryan Southall
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¢ Start day - day of the year for sky creation (integer input, day of the year is shown in the option label)

¢ Animation - sets a parametric sky creation. If on, the following options are presented:

s Start frame - sets the start frame for the animation

[
K

>k
K

End frame - this is an auto-calculated number based on the options below

End hour - end hour for the simulation (decimal input, hours and minutes are shown in the option
label).

End day for the simulation (integer input, day of the year is shown in the option label).
Interval (hours) - the amount of time between simulations.

o Turbidity - sets the turbidity of the sky

o HDR - creates an HDR image of the sky in the project directory that can be used as an environment
texture in Blender.

¢ Split channels - keeps separate the three frequency bands simulated

o CBDM

[¢]

[¢]

[¢]

[¢]

[¢]

[¢]

¢ Type:

* Exposure - generates a cuamulative HDR image of the sky for the simulated duration for exposure

calculations

* Hourly irradiance - calculates full spectrum irradiance exposure for each hour of the simulation
* DA/UDI/SDA/ASE - calculates conventional CBDM metrics

- (s)DA Min lux - sets the minimum lux level for (spatial) Daylight Autonomy
- UDI Low (Max) - sets the maximum lux level for the Useful Daylight Illuminance (UDI) low

level

- UDI Supplemental (Max) - sets the maximum lux level for the UDI supplemental level
- UDI Autonomous (Max) - sets the maximum lux level for the UDI autonomous low level
- ASE level - sets the upper limit for ASE calculations.

* Glare - calculates annual glare metrics

- Hourly DGP - calculates an hourly glare occurance/autonomy in addition to an annual sum-

mary for heatmap visualisation

- DGP threshold - sets the glare probability threshold for glare occurance/autonomy
- Views - sets the number of view directions for the glare simulation
- Azimuth - sets the azimuth of the first view direction (each subsequent view azimuth is calcu-

lated as an additional 360°/Views clockwise rotation)

All year - does the calculation for an entire year

o If off, start and end day and hour can be set

Source file:

Weekdays - only calculate a sky for weekdays if, for example, simulating a commercial environment

LEED v4 - sets ASE and (s)DA levels for a LEED v4 calculation if “Type” is set to DA/UDI/SDA/ASE

o EPW - generates sky data from the EPW file selected in the VI Location node

© HDR - use a pre-generated HDR sky for exposure calculations

o VEC - use a pre-generated vector description of a sky for CBDM and irradiance analyses

Resolution - sets the patch resolution for the generated sky (1 = 147 patches, 2 = 578 patches)

HDR - generates a composite HDR panorama of the sky in the project directory.

Dr Ryan Southall
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4.13.3 The LiVi Simulation node

The LiVi Simulation node (figure 27) can be added to the VI-Suite Nodes tree with the “Add > Simulation nodes >
LiVi Simulation” menu entry. This node takes geometry and context from LiVi Geometry and LiVi Context nodes
and calculates the chosen metric on sensing geometry. The "Calculate" button, which is only visible if there is valid
sensing geometry, initiates the simulation. When the "Calculate” button is pressed the Blender interface will lock
up during the simulation but a Kivy window will appear that shows an estimate of simulation duration, and presents

a cancel button to terminate the simulation.

The node has two input sockets: "Context in", which accepts
connections from a "Context out" socket of a LiVi Context node
and "Geometry in" for connection to the "Geometry out" socket of
a LiVi Geometry node. Once valid socket connections have been
made the following node options are exposed:

o Frames - auto-generated text label showing the frame range
to be simulated based on the extents of the frame ranges set
in the LiVi Geometry and LiVi Context nodes.

o Photon map - this enables Photon mapping, a forwards ray-
tracing technique that is very useful when rays from the cal-
culation point find it difficult to find a light source. If using a
custom Radiance installation, at least version 5 of Radiance
is required:

S 00 0

%

v LiVi Simulation

Frames: 18 - 18

Photon map:

iid)

VI results

U

Accuracy: Initial v

[ Camera v] [

Preview

)

[ Calculate

]

Geometry in

Context in

|

Figure 27: LiVi Simulation node

Back face visibility - this makes both sides of planes accept photons.

photon mapping manual for more information about potential options.

Global photons - sets the number of global diffuse photons to be emitted and registered within the scene

Caustic photons - sets the number of specular photons to be emitted and registered within the scene

Photon options - text box to set advanced options for the mkpmap program. Refer to the Radiance

¢ Preview photons - when pressing the “Preview” button this will create spheres within the Blender scene
to map where global and caustic photons have landed. The global photons object is called GlobalPM
and the caustic CausticPM and both are saved to the LiVi Results Blender collection.

o Accuracy - sets an accuracy preset:

¢ LiVi Basic offers low, medium and high settings

o LiVI CBDM offers initial and final settings

o All analyses types offers custom parameters - a text box where Radiance simulation parameters can be

specified

o Camera - a drop-down menu to choose a Blender camera to preview the scene with Radiance. Only available
if LiVi Basic, or a LiVi CBDM exposure analysis is being conducted.

o Preview - button to open a Radiance rvu window to preview the scene from the perspective of the chosen
camera. Only available if LiVi Basic, or a LiVi CBDM exposure analysis is being conducted.
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4.13.4 The LiVi Image node

A LiVi Image node can be added to the VI-Suite Nodes tree with “Add > Image Nodes > LiVi Image” menu entry.
The LiVi Image node creates a Radiance image from the information embedded in the LiVi Geometry and LiVi
Context nodes and has the same input socket connections as a LiVi Simulation node. Once valid connections have
been made, at the top of the node the simulation frame range generated by the LiVi Geometry and LiVi Context
nodes will be shown. Image(s) are created from the perspective of the chosen Blender camera with the node’s
“Image” button, and will be saved to the project directory/images folder with the name(s) base name-frame.hdr
where base name is set within the node and frame is the simulation frame. During creation of the image, a preview
of the developing image will be displayed in the livi_preview image in Blender’s image editor.

Once valid socket connections are made, and a Blender camera
selected with the drop down box, options in the node will appear.
These options include:

o

Camera - Blender camera selection menu
Base name - base name for the images produced

Iluminance - turns on an illuminance image rather that a
luminance image (illuminance images will make all initial
ray hits based on white, diffuse geometry)

Fisheye - creates a fisheye image

o FOV - field of view in degrees (should be 180 for glare
analysis)

Accuracy - sets the Radiance accuracy
¢ Options here are the same as the LiVi Simulation node

Normal - generates an additional coloured image of surface
normals for later de-noising with Blender

Albedo - generates an additional coloured image of surface
albedo for later de-noising with Blender

Photon map - turns on the Radiance’s photon mapping cap-
ability

< Options here are as for the LiVi Simulation node

¢

v LiVi Image

ET

Image l

Frames: 1 -1

Camera: (S Camera

X

Base name:
llluminance:
Fisheye:

Accuracy: Low
Normal:

Albedo:

Doolosi

Photon map:

[ Preview

-

X resolution: 2000

Y resolution: 1000

Multi-thread:

[ Image

__/

Geometry in

Context in

Figure 28: LiVi Image node

Preview - creates a preview of the scene with Radiance’s rvu program

X resolution - sets the X pixel resolution of the image
Y resolution - sets the Y pixel resolution of the image

Multi-thread - on Linux and OS X enables multi-processing

© Processors - sets the number of processors available for multi-processing

o Processes - splits the image into this many segments for multi-processing

Image - creates the image(s)

4.13.5 LiVi Glare node
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The “LiVi Glare” node can be added to a VI-Suite Nodes tree from

the Add > Image nodes > LiVi Glare’ menu entry. It has one LiVi MEMIGlere )

Image input socket which connects to the output of a LiVi Image Base name:

node and processes the images created to evaluate glare probabil-

ity. Random:
Glare analysis works on fisheye images so the fisheye option [ Glar ]

should have been selected in the LiVi Image node and an FOV of are

180 degress set. The “Illuminance” option should also be turned (8 Image

off in the LiVi Image node. In addition, glare analysis on fisheye

images larger than 1000x1000 pixels can take a long time. Glare . .
images are stored in the Project directory/images folder. Figure 29: LiVi Glare node
The node contains two options:

o Base name - sets the base name of any generated images, which are given the name base name-frame.hdr
o Random - randomly colours glare sources if on. Allows a single colour selection for all glare sources if off

o Colour - if “Random” is off, select colour for all glare sources

4.13.6 LiVi False Colour node

The LiVi False Colour node can be added to the node tree with the
“Add > Image nodes” menu in the VI-Suite Nodes tree window.

T ) ; k v LiVi False Colour ™
The LiVi Fglse Colour. node applies a false COl.OU.I‘ filter to Radi- (77635 v textimages/fe-Lhdr B
ance HDR images, which can come from the LiVi Image node or hoee e
be loaded from disk. This filter colours the image according to .
the lighting data embedded within it. If the image comes from
the LiVi Image node, the type of data embedded in the image de- uiipler
pends on options in the LiVi Context and LiVi Image nodes. If, for Colour:
example, the LiVi images are generated with the “Visible” spec- Legend:
trum option in the LiVi Context node, then illuminance (lux) or e
luminance (cd/m?) data is available. Which is of these is avail- Divisions:
able is determined with the “Illuminance” option in the LiVi Im- Legend max:
age node. If the “Full” spectrum option is used in the LiVi Context Legend width:
node then irradiance (W/m?) and radiance (W/m?2.sr) are available, Legend height:
again switched between with the “Illuminance” option in the LiVi G
Image node. If loading the file from disk, then the user should be CoiE
aware of which unit is embedded in the image. Overlay file: (77035 i texti.. [am)

The node has one input “Image” socket. If this socket is not o )

1 A X verlay exposure:
connected the user can load an hdr image from disk with the node’s ( r— ]
file browser. If the socket is linked to a LiVi Image node then the )

. . mage
images created with that node can be processed.
Once either an image has been loaded or a valid socket link has ) o
been made, the following options are presented: Figure 30: LiVi False Colour node

o Base name - text box to set the base name for the produced false colour image (file name will be base name-
frame.hdr)

o Unit - text box to set the legend unit
Once a unit has been entered the following options are presented:

o Multiplier - sets a multiplication or division factor for the results (/100 would divide the results by 100, *100
would multiply by 100)

o Colour - sets the legend and image colour scale
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o Divisions - sets the false colour divisions

o]

Legend - turns on legend display

[}

Scale - sets the legend number scale: linear or logarithmic

o Legend max - sets the maximum legend number

o

Legend width/height - sets the display width/height of the legend

[¢]

Contour - draws contours over the image

¢ None - no contours

< Contour - draws contour lines at legend colour boundaries
© Bands - draws bands at legend colour boundaries

o Poster - fills the image with legend colour designations

¢ Overlay - overlays the contours over a selected image

* Overlay file - selects the image to overlay contours
* Sets the exposure (as a multiplier) of the overlaid image
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4.14 EnVi Nodes

EnVi nodes control the main phases of an EnergyPlus simulation: The EnVi Geometry node processes Blender
geometry for export; the EnVi Export node exports processed geometry and context to EnergyPlus format; the
EnVi Simulation node runs the Energyplus simulation.

4.14.1 The EnVi Geometry node

The EnVi Geometry node (figure 31) processes Blender scene geo-

metry and materiality into a form more suitable for EnergyPlus < Envi Geometry B |
analysis, which requires a very different level of geometric detail Geometry out
than that typically used within Blender. The node contains one offset (x 2om [ Y om ][ z om]
"Export" operator button. Upon pressing the "Export" button the ( Export )
node processes all visible mesh objects designated as EnergyPlus

surfaces and all mesh faces with an EnergyPlus material associ- Figure 31: EnVi Geometry node

ated, and displays it in Blender with a positional offset set with the
’Offset’ value within the node. This new geometry will also be coloured to designate the the kind of construction
that has been specified via the EnVi material specification: brown - floor, light grey - walls, green - roof, turquoise
- windows, yellow - party walls/floors and blue - PV panels.

These colours will also be applied to the original geometry but the change only applies to Blender’s viewport
display, not to the actual Blender material characteristics one sees when rendering out the scene.

This new geometry is also placed in an EnVi Geometry collection, with sub-collections based on the collection
organisation of the original geometry.

If changes are made to the original geometry the "Export" button should be re-pressed to reprocess. The node
has one output socket, "Geometry out" for connection to an EnVi Export node’s "Geometry in" socket.

4.14.2 The EnVi Context node

The EnVi Export node converts the modified Blender geometry
and materiality within the EnVi Geometry collection to a valid En-
ergyPlus text description, and combines it with the weather data
specification in the connected VI Location node, which must have
"EPW" selected as its information source. The context and desired Shadow: CPU
simulation metrics presented within this node complete an En-
ergyPlus text input file. The input file created is called inframe.idf, O
where frame is the Blender frame being simulated, and is stored in Name/location: :]
the project directory. It is also registered within Blender’s text ed- Solar:
itor, and can be edited before eventual simulation if required. Exposure;
The node has two input sockets: "Geometry in" for connection e Ty
to an EnVi Geometry node’s "Geometry out" socket and "Location '
in" to connect to a VI Location node’s "Location out" socket, and End day 31/12: 365
one output socket "Context out", for connection to an EnVi Simu- Time-stepshour (4 ]
lation node’s "Context in" socket. P e
If valid input socket connections are made, node options are —
presented and an "Export" button will appear at the bottom of the Temperature [ Humidity

>

v EnVi Context

Context out O

<

Animation:

node. Options are: Heating (J Cooling
o Shadow - sets the method for shading calculations: Air heating ) e
(J Air cooling (J) solar gain

© CPU - uses the cpu.
. . . (J Heat balance (0 Equipment
o GPU - uses the graphics card. GPU can be quicker if

there are a large number of shading surfaces. [
@ Geometry in

m
x
©
<}
3
__J

() Location in

Figure 32: EnVi Export node
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o Animation - designates an animated/parametric EnergyPlus export

¢ Start frame - sets the beginning frame for the parametric analysis

¢ End frame - sets the end frame for the parametric analysis

o Name/location - provides a text box for the optional entry of an EnergyPlus project name

o Solar - sets the accuracy of solar radiation gain calculations (refer to EnergyPlus documentation)

o Exposure - specifies the level of wind exposure the building is subject to.

o Start/end day - specifies the beginning and end day for the simulation.

o Time steps - specifies the number of simulation time steps per hour

o Results category - chooses the class of metrics to be calculated and presents individual tick boxes for specific

metrics within the chosen class. Options are:

o
o
o
o
© Power - photovoltaic power production and efficiency
o

Surface - surface inside and outside temperatures

Comfort - zone PPD, PMV, MRT and occupancy levels

Zone Ventilation - zone infiltration, exfiltration and CO5

Zone Thermal - zone heating, cooling, temperature and humidity results

Ventilation Link - flow rates, opening factors and pressure differences in ventilation networks

Upon pressing the “Export” button the inframe.idf file is created in the project directory and the "Context out"

socket will become visible.

4.14.3 The EnVi Simulation node

The EnVi Simulation node (figure 33) initiates an EnergyPlus sim-
ulation. The EnVi Simulation node has two sockets: "Context in"
for connection to another node’s "Context out" node, and "Res-
ults out" for connection to a VI Chart node, VI Heatmap node,
VI Metrics node or a VI CSV node. The node contains a text
box into which the name of the EnergyPlus results file (default
is "results") can be specified. Once a valid socket connection has
been made to the "Context in" socket a "Calculate" button appears,
which when pressed initiates the EnergyPlus simulation. The node
will then turn red and will monitor the EnergyPlus simulation and
give a prediction of simulation progress with a Kivy window. The
Blender interface should remain interactive during simulation but
no changes to the Blender scene should be made while the sim-
ulation is running. A results file, with the name results name-
frameout.eso, is saved in the project directory upon completion.

v EnVi Simulation

Results name: | results

T

VI results €

[ Calculate

J

(8 Context in

L

Figure 33: EnVi Simulation node
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4.15 EnVi Network Nodes

EnVi Network Nodes are used within the EnVi Network node tree to specify zone schedules and natural ventilation

networks.

4.15.1 The EnVi AFN node

The EnVi AFN node is created automatically within the
EnVi Network node tree during EnVi geometry conver-

; =5
sion but is only relevant if EnVi airflow surfaces are  EnVIAFN -
present. If accidentally deleted, the node can be recre- Name: [ ]
ated with the ’Add > Airflow Nodes > Airflow Control’ : :
menu. The EnVi AFN node specifies the high level Type: [ MultizoneWitho... V]
options for a ventilation network. For more details WPC type: [ SurfaceAverag... v]
of these options refer to the “AirflowNetwork:Simu- . :
lationControl” entity in the EnergyPlus input/output Build type: [ Low Rise "J
referenc.e document but options the user may need to Max iter: [ 500 ]
change include:
Init method: [ ZeroNodePress... vJ
o Name - allows for an optional custom name to
bet set for the airflow network Rel Converge: [ 0.000 ]
o WPC type - sets the calculation for external wind Abs Converge: [ 0.00000 J
pressure coefficients Converge Lim: [ 20.10 ]
¢ SurfaceAverageCalculation - automatic cal- Azimuth: [ 0 J
culation based on the building typology op- . _
tions in this node Axis ratio: [ 1.00 ]

* Build type - sets whether the building
is high rise or low rise

* Azimuth - azimuth angle of the long
axis of the building

* Axis ratio - ratio of the long axis to the
short axis of the building

< Input - input wind pressure coefficients cal-
culated by, for example, FloVi.

Figure 34: EnVi AFN

* WPC height - sets the height for the wind pressure coefficients
- OpeningHeight - automatically set according to the height of the airflow network components
- ExternalNode - set by the External nodes attached to each external airflow component

* Setting “Input” will expose an Azimuth array input socket for the connection of an EnVi Azi node
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4.15.2 The EnVi Azi node

This node can be added by selecting the Add > Air-
flow Nodes > Azimuth Array’ menu entry in an EnVi
Network node tree. The node supplies azimuth angles,
in clockwise degrees from North, for all the wind pres-
sure coefficients applied to external building surfaces Azimuth source
via the EnVi External nodes in the EnVi Network node
tree, and connects to the EnVi AFN node via a single
Azimuth array output socket.
Options presented in this node are:

v EnVi Az =

Azimuth array

Azimuth angles

90

o Azimuth source - the source of the azimuth angle 180

data

270

(

[

[

(

¢ Manual - up to 12 azimuth angles can be [
entered manually (these must be in ascend- [
ing order and the list will terminate if val- [
[

(

(

[

[

ues descend)

© CSV - azimuth angles are read from a CSV
formatted file (the CSV file should contain
only one column with the word azimuth in
the first row header)

U W . U W U U ) W . U U ) W W W

ofloflo|lo]lo||lo]||lo|]lo

* File opening dialogue to open the CSV
file

* Azimuth angles are then displayed
from the CSV file

Figure 35: EnVi Azi node

In the example in figure 35, 4 azimuth angles have been manually input in ascending order and the rest are ignored.

4.15.3 The EnVi Zone nodes

EnVi Zone nodes are created automatically in the EnVi Network
node tree during EnVi geometry conversion for each thermal zone,
or collection, that was exported. The node represents an En-
ergyPlus ’Zone’ entity, so see the EnergyPlus documentation on
this entity for further details of the options available. Input sock- Zone: EN_STUDIO
ets are created for HVAC, occupancy, equipment and air infiltration
schedules. If EnVi material constructions associated with the ob-
jects within an exported collection have airflow or zone boundary
characteristic, sockets are also created for these surfaces. Bound- Volume calc: Auto
ary sockets are coloured brown, surface airflow sockets red and Auto volume: 183.3
sub-surface airflow socket green. These additional sockets are cre-
ated on both sides of the node for easier arrangement of connec-

v EnVi Zone &

Win_af_18_s

Inside convection: Default

Outside convection: Default

Control type: None

tions within the node editor. P Hvac
Core options within this node are: PARssHRancy
® Equipment
o Zone - auto-generated name of the Blender collection that © Infiltration

deleted, a new node can be created with the ’Add > Zone
nodes > Zone’ menu and a name manually inputted. This
should correspond exactly to the name of the collection and
is case sensitive.

represents an EnergyPlus zone. If the node is accidentally ¥ VASchedule

Win_af 5_s

Figure 36: EnVi Zone node
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o Inside convection - sets the routine for internal surface convection
o Outside convection - sets the routine for external surface convection
o Volume calc:

© Auto attempts to calculate the zone volume from the objects in the collection

* Auto volume - auto generated text of the calculated volume (this should be checked to make sure
the calculated volume corresponds to expectations. Use the manual option if not)

¢ Manual - the user can enter a volume (m?)
o Control type - sets the zone level of control of any airflow openings:

¢ Constant - openings can always open
¢ Temperature - opening is restricted based on zone temperature

s Minimum OF - the minimum opening factor
* Lower - the lower temperature difference threshold
* Upper - the upper temperature difference threshold

* An additional node input socket called TSPSchedule is exposed for the connection of a Schedule
node to set the temperature at which air flow openings operate.

The core node input sockets exposed are:
o HVAC - for the connection of an HVAC node to set heating and cooling provision
o Occupancy - for the connection of an Occupancy node to set occupancy levels
o Equipment node - for the connection of an Equipment node to set equipment heating gains
o Infiltration - for the connection of an Infiltration node to set simple zone air infiltration

o VASchedule - for the connection of a Schedule node to set when airflow openings are available. If not
connected ventilation openings are always available.

In addition to these core sockets, additional sockets will be created if EnVi construction materials with a boundary
or airflow characteristic are associated with object within the collection. These sockets will initially appear on both
sides of the node but will disappear from the opposite side as they get connected. These additional sockets are:

o Boundary sockets - coloured brown are for connection to the corresponding boundary socket of another zone
node.

o Surface airflow sockets - coloured red are for the connection to a surface airflow node.
o Sub-surface airflow sockets - coloured green are for the connection to a sub-surface airflow node

The example in figure 36 shows a basic zone node with two sub-surface (windows & doors) airflow sockets. These
two flow components originally express themselves as two input sockets and two output sockets but if a socket
is connected the same socket on the opposite side will disappear (the example in figure 36 shows one connected
airflow socket as an input and one connected as an output). These additional socket names are derived from the
name of the material associated with the face, the index number of the face and at the end of the socket name an
"s" denotes a surface or sub-surface flow and "b" at the end of the socket name would denote a boundary surface.
In, Glass_5_s denotes that Blender material “Glass” is associated with a face with an index of 5 that represents a
surface or sub-surface flow. For information on visualising face index numbers see section 4.4)

Boundary sockets should be connected to another boundary socket on another zone node. The VI-Suite then
assumes that the connected surfaces represent a boundary between these two zones. If a boundary node is left
unconnected the VI-Suite will consider this is an external boundary as if an “External” boundary condition had
been set for the associated face material.
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Surface and sub-surface flow sockets must be connected to an EnVi Surface flow node (section 4.15.9) or an
EnVi Sub-surface flow (node section 4.15.10) respectively. If the flow node has no other connection, this flow
component is considered to sit on the external boundary of the building. If the flow node has another connection
to another zone node, the flow component is considered to sit on the boundary between these two zones.

When all airflow sockets are connected the node becomes valid and will turn the default colour. It should be
noted that if airflow surfaces are designated, then each EnVi zone must have at least two airflow surfaces specified

within it during geometry creation, and at least two pairs of flow sockets should appear in the node.

4.15.4 The EnVi HVAC node

The EnVi HVAC node is available in the ’Add - Zone Nodes
> HVAC’ menu in an EnVi Network node tree and specifies
heating and cooling levels for a connected EnVi Zone node
by creating an EnergyPlus IdealLoadSystem entity. For fur-
ther details of the options within this node refer to the En-
ergyPlus inputoutput reference document entry for this en-
tity.

As EnergyPlus was developed in the United States where
the heating and cooling of buildings with air is common, and
of the EnergyPlus options pertaining to the supply of heat-
ing and cooling reflect this. Node options are broken down
into three sections: heating, cooling and outdoor air. Most
of the heating options have a direct corollary in the cooling
section of the node. The level of outdoor air supplied by the
heating/cooling system can be used as a simple method to
calculate the impact of MVHR systems. Options within this
node include:

o Heating limit:

© None - no heating.

¢ No limit - heating is unlimited in terms of the air
flow rate that can be supplied or the capacity to
heat the air

* Heating temp - temperature of the supply air
(°C)

* Thermostat level - zone temperature below
which heating is applied (°C)

¢ LimitFlowRateAndCapacity - limit the overall ca-

pacity and the airflow rate of the heating system.

* Heating temp - temperature of the supply air (°C)
+ Heating airflow - maximum volume flow rate of the supply air (m?/s)

v HVAC

Heating -----------
Heating limit:

Heating temp:

Thermostat level:

Heat recovery:
Cooling ------------
Cooling limit:

Cooling temp:

Cooling capacity:
Thermostat level:

Outdoor air ----------

Outdoor air:
Schedule
HSchedule
CSchedule

[NoLimit v]
[ °c 50.00 |
([ °c 2000 ]
( None v)

°C 13.00

Figure 37: EnVi HVAC node

* Heating capacity - maximum heating capacity of the supply air (W)

* Thermostat level - zone temperature below which heating is applied (°C)

¢ LimitCapacity - limit only the overall capacity of
the heating system.

* Heating temp - temperature of the supply air (°C)

* Heating capacity - maximum heating capacity of the supply air (W)

* Thermostat level - zone temperature below which heating is applied (°C)

¢ LimitFlowRate -limit only the airflow rate of the
heating system.
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* Heating temp - temperature of the supply air (°C)

+ Heating airflow - maximum volume flow rate of the supply air (m?/s)

* Thermostat level - zone temperature below which heating is applied (°C)

o Heat recovery - turns on sensible heat recovery.
o HR eff. - sets the heat recovery efficiency
o Outdoor air

None - purely recirculating air heating system
Flow/Zone - flow for the zone (m?/s)

Flow/Person - flow per current occupant

ACH/Detailed - air changes per hour

Sum - sum of all the outdoor air flow types

[ IR e IR <R IR e I o

In addition, the node has three input sockets:

Flow/Area - flow per m? of floor area (m?3/s/m?)

Maximum - maximum of the outdoor air flow types

o Schedule - for the connection of a schedule node to determine when the heating/cooling system is available

(schedule values: 0 or 1).

o HSchedule - for the connection of a schedule node to provide time varying heating thermostat set point

temperatures (schedule values: temperature).

o CSchedule - for the connection of a schedule node to provide time varying cooling thermostat set point

temperatures (schedule values: temperature).

4.15.5 The EnVi Occupancy node

The EnVi Occupancy node is available in the “Add > Zone

v Occupancy

e

N

Occupancy

!

Nodes > Occupancy” menu in an EnVi Network node tree Type: Occupants v
and specifies the type and nature of any occupancy within a
connected EnVi zone node. Occupancy is set as a maximum Max level: 5.00
occupancy level within this node and an attached schedule . .
node can set the fractional schedule of this maximum level. Activity level: Wip 90
The options within the node control: Comfort calc:
o Type of occupancy: Work efficiency: 0.00
¢ None - no occupancy. Air velocity: 0.10
© Occupants - occupancy in terms of number of )
people. Clothing: 0.50
* Max level - maximum number of occupants COo2: C]
* Activity level - metabolic sensible heat out- 0OSchedule
put per person (W/p)
o Persons/m?- number of people per square meter ASchedule
of floor area. WSchedule
# Max level - maximum number of people per VSchedule
square metre
* Activity level - metabolic sensible heat out- CSchedule J
put per person (W/p)
Figure 38: EnVi Occupancy node
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o m?/person - square meter of floor area per per-
son.

* Max level - maximum number of square metres per person (in terms of occupancy the max level
is the lowest number)

* Activity level - metabolic sensible heat output per person (W/p)
o Comfort calc - turn on thermal comfort calculations

<o Work efficiency - proportion of the metabolic rate expended in useful work
o Air velocity - average air velocity for comfort calculation (m/s)
¢ Clothing - clothing level of the occupants (clo)

¢ COg - turn on the calculation of internal CO4 levels
The node also contains sockets for the connection of schedule nodes:

o OSchedule socket is for the scheduling of occupancy level as a proportion of the maximum specified occu-
pancy (schedule type - fraction)

o ASchedule socket for the schedule of the absolute metabolic rate (schedule type - value)

[¢]

WSchedule for the scheduling of the proportional level of the work efficiency (schedule type - fraction)

[¢]

VSchedule for the scheduling of absolute air velocity in m/s (schedule type - value)

[¢]

CSchedule for the scheduling of absolute clo clothing level (schedule type - value).

4.15.6 The EnVi Equipment node

The EnVi Equipment node is available in the “Add
- Zone Nodes” menu in an EnVi Network node tree
and specifies the level of mechanical and electrical in-
ternal heat gains. The node contains one “Equipment” Equipment
output socket for connection to the “Equipment” input

v Equipment »,

socket of an EnVi Zone node. The node also con- TYpe: [EquipmentLevele
tains an input socket for the connection of a sched- Max level: [ 1.00 J
ule node to set a scheduled value for the specified heat

. ([) Schedule
gain.

The options within this menu include: Figure 39: EnVi Equipment node

o Type - sets the type of equipment gain.

< None - no gains
< EquipmentLevel - sets the total Watts of internal gains for the zone (W)
o Watts/area - sets the internal gains in Watts per square metre of floor area (W/m?)

© Watts/person - sets the Watts per occupant (W/p)
o Max level -sets the maximum gain based on the previously selected gain type.

o Schedule - an input socket that accepts a schedule for gains of the type selected (schedule type - amount)

4.15.7 The EnVi Infiltration node
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The EnVi Infiltration node is available in the *Add > Zone
Nodes > Infiltration’ menu in an EnVi Network node tree and
sets a constant or scheduled level of fresh air infiltration into Infiltration @
a zone. If an air-flow network is specified this node, and

the settings within it, will be ignored. The node contains one Type: Flow/Zone ~

v Infiltration [op

“Infiltration” output socket for connection to an “Infiltration”
input socket of an EnVi Zone node, and one input socket for Level (m?/s): 0.01
the connection of a schedule node to specify a fractional in- (B Schedule

filtration rate.

The node sets two options: Figure 40: EnVi Infiltration node
o Type - sets the type of infiltration

< None - no infiltration

o Flow/Zone - total flow for the whole zone in m?/s.

o Flow/Area - flow per square metre floor area in m®/s-m?

o Flow/ExteriorArea- flow per square metre of exterior surface area in m>/s-m?

o Flow/ExteriorWallArea - flow per square metre floor of exterior wall area in m*/s-m?

¢ ACH - total flow in air changer per hour
o Level- sets the level for the previously selected infiltration type.

o Schedule - an input socket to attach a schedule node (schedule type - fraction)

4.15.8 The EnVi Net Schedule node
The EnVi Net Schedule node can be found in the Add >

Schedule’ menu in the EnVi Network node tree. A schedule < Envi Net Schedule )
node creates an EnergyPlus schedule, which is used to con- ScheduleJ}
trol an input’s time dependence e.g when windows are open. Source (Node J
All EnVi schedules basically operate over defined periods of End day 1: ( %° J
a year, for defined days within that period, and defined hours Fors: (atdeys )
of those days. The node options reflect the specification of :::';yz [[08:00 SR ;’624:000 }
these three layers of time data. Values provided are either Fors: (eakdays weskencs ]
absolute values e.g. a thermostat temperature schedule, or Untils: (08:000, 20:00 1, 24:00 0, 24:000 )
fractional e.g. the proportion of occupancy schedule. The

node is initially red and will only become the default colour Figure 41: EnVi Schedule node

when the options below are given valid values.
These options are:

o Source - only Node works and simply reads the schedule from the options below

o "End day 1" - sets the end day of the first scheduled year period, which will start at 1. This defaults to 365,
the last day of the year.

o "Fors" - sets the day types (valid day types are: Alldays, Weekdays, Weekends, Monday, Tuesday, Wednes-
day, Thursday, Friday, Saturday, Sunday and AllOtherDays) for the above year period in a space separated
list. weekdays weekends would for example set two day types for the next "Untils" option.

o "Untils" - sets the schedule values with space separated end hour:minute/value pairs, comma separated for
each period within a day type and semi-colon separated for each day type. A whole day period must be
covered so 24:00 should always be the last time specified.
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If the first end day is less than 365 the three options above are repeated for the next year period. Up to four year
periods can be set.

For example, in figure 41 for the first period up to day 90, then for all days in that period the schedule is 0 until
08:00, 1 until 18:00 and 0 until 24:00. For the next period from day 90 to the end of the year (day 365) for weekdays
the schedule is 0 until 08:00, 1 until 20:00 and 0 until 24:00, and for weekends the schedule is 0 until 24:00. The
node presented in figure 41 represents a fraction schedule where the schedule values are the decimal fraction of a
maximum value. Refer to the EnergyPlus user manual for clarification of what schedule type is required to control
which parameter.

4.15.9 The EnVi Surface Flow node

The EnVi Surface flow node creates a permanent apertures within
a solid building construction such as a wall, floor or roof. It con-

. i v Envi surface flow =
tains two input sockets "Node 1" and "Node 2", and two output -
sockets "Node 1" and "Node 2". Having sockets on both sides of Node 2
the node makes node connections within the node tree more flex-
ible but only one needs to be connected, so if a node socket on one Type: [ ELA

side of the node is connected, the similarly named socket on the
other side of the node will disappear. All of these sockets are for
connection to the surface flow sockets of EnVi Zone nodes. DC:

If both "Node 1" socket and "Node 2" sockets are connected to
two different EnVi zones the surface flow node is assumed to spe-
cify a flow component between the two zones. If only one socket FE: 0.650
is connected to an EnVi Zone node, the surface flow is assumed
to sit on the external boundary of the zone and control airflow ; Node 1

ELA (m™2): ela 1.000

PA diff (Pa):

o
S
o
<
<

between the zone and the outside air. If "Input" is selected for the Node 2
"WPC type" in the EnVi AFN node, an EnVi External node must
then be connected to the other socket to represent outside condi-
tions.

Figure 42: EnVi Surface flow node

Options in this node include:
o Type - the type of flow component (effective leakage area (ELA) or crack)

o ELA - aperture is represented by an effective leakage area
# ELA (m/2) - area in m?
* DC - discharge coefficient
* PA diff - reference pressure difference (Pa)
* FE - flow exponent
o Crack - aperture is represented by a crack
* Coefficient - flow coefficient
* Exponent - flow exponent
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4.15.10 The EnVi Sub-surface Flow node

The EnVi Sub-surface Flow node creates a flow component
within an opening building construction such as a window or
door. It contains two input sockets "Node 1" and "Node 2",
and two output sockets "Node 1" and "Node 2". All of these
sockets are for connection to the sub-surface flow sockets of
EnVi Zone nodes. If a node socket on one side of the node is
connected the similarly named socket on the other side of the
node will disappear. This makes node connections within the
node tree more flexible. If both "Node 1" socket and "Node
2" socket are connected to two different EnVi zones the sub-
surface flow is assumed to control airflow between the two
zones. If only one socket is connected to an EnVi zone node
the surface flow is assumed to sit on the external boundary
of the zone and control airflow between inside and outside.

An additional socket is the "VASchedule" socket which
allows for the specification of a venting availability schedule
for the component.

The "Control type" option sets the criteria for the open-
ing and closing of the component. ’None’ means the win-
dows doors are always closed, ’Zone’ means they open/close
according to the ventilation control of the parent EnVi
Zone’ node, “Constant” sets opening/closing according to
the schedule attached to the “VASchedule” socket and
"Temperature" sets opening/closing based on a temperature
thermostat schedule attached to the exposed “TSPSchedule”
socket.

Options in this node include:
o Type - the type of flow component

¢ Simple opening - simple controllable opening

v Envi sub-surface flow =2

<
-

Type: [ Simple Opening

Win/Door OF: 0.10

Control type: Zonelevel

Component options:

Closed FC
Closed FE
Density diff
DC 0.65
VASchedule

Node 2

Figure 43: EnVi Sub-surface flow node

* Win/Door OF - the maximum level of opening of this window/door

* Control type:

- Zone level - control is set be the options in the attached EnVi Zone node

- None - no control is applied

- Constant - window/door is constantly open

- Temperature - temperature control for this specific opening (exposes a TSPSchedule input

socket to set a temperature schedule)

Component options - sets the specifics of the flow component:

* Closed FC - flow coefficient when the window/door is closed
* Closed FE - flow exponent when the window/door is closed
# Density diff - minimum density difference for two way flow (kg/m?)

* DC - discharge coefficient

¢ Detailed opening - detailed controllable opening

* Win/Door OF - the maximum level of opening of this window/door

* Control type:

- Zone level - control is set be the options in the attached EnVi Zone node

- None - no control is applied
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- Constant - window/door is constantly open

- Temperature - temperature control for this specific opening (exposes a TSPSchedule input
socket to set a temperature schedule)

Component options - sets the specifics of the flow component:

x
K
>k

*

* ¥ ¥ ¥

*

Closed FC - flow coefficient when the window/door is closed
Closed FE - flow exponent when the window/door is closed
Opening type:

- NonPivoted - side opening window/door

- HPivoted - horizontal pivoting window/door
Crack length -extra crack length or height of pivoting axis

OF Number - sets the number of opening factors. For each opening factor (up to a maximum of 4)
the following options are presented:

OF - opening factor

DC - discharge coefficient for opening factor
Width OF - width factor for opening factor
Height OF - height factor for opening factor

Start height OF- start height of the opening factor

< Horizontal opening - horizontal controllable opening

3k

Control type:
- Zone level - control is set be the options in the attached EnVi Zone node
- None - no control is applied
- Constant - window/door is constantly open

- Temperature - temperature control for this specific opening (exposes a TSPSchedule input
socket to set a temperature schedule)

Component options - sets the specifics of the flow component:

)
3
K
%k

Closed FC - flow coefficient when the window/door is closed
Closed FE - flow exponent when the window/door is closed
Slope - opening angle relative to horizontal (90 is fully open)
DC - discharge coefficient

¢ ELA - uncontrollable effective leakage area aperture

>k
%k
K
3k

ELA (m/2) - area in m?

DC - discharge coefficient

PA diff - reference pressure difference (Pa)
FE - flow exponent

¢ Crack - uncontrollable crack aperture

K
3k

Coefficient - flow coefficient
Exponent - flow exponent
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4.15.11 The EnVi External node v Envi External =
The EnVi External node can be added from the *Add > Air- Sub surface
flow Nodes > External air’ menu and provides wind pressure Surface
coefficients for the outside surfaces of the building. These
nodes are only required if the "WPC type" option in the EnVi WPC source:
AFN node is set to "Input". The node has sub-surface flow
and a surface flow sockets as both inputs and outputs. Join- [ height 1.00 ]
ing these sockets to a flow component specifies the build-
. . . g WPC Values
ing wind pressure coefficients for the angles specified by an
Azimuth Array node. An Azimuth Array node is therefore WPC1:
required to be connected to the EnVi AFN Control node for
. WPC2:
these nodes to be valid.
Options within this node are: WPC3:
o WPC source: WPC4:
© Manual - manual user entry of up to 12 wind WPCS5:
pressure coefficients. These values should cor-
respond with the azimuth angles entered into the WPCB6:
Aximuth Array node. WPC7:
© CSV - wind pressure coefficients are read from
CSV file WPCS:
# Select - file opening dialogue to select the WPC9:
CSV file
* Probe - the name of the probe location to WPC10:
load WPCs for WPC11:
* Azimuth and WPC values are shown within
the node WpCl2:
Sub surface
$ Surface

Figure 44: EnVi External node

4.16 EnVi Material Nodes

Version 0.6 of the VI-Suite has moved to using nodes to specify building constructions for EnergyPlus. This allows
the maximum number of EnergyPlus layers (10) to be specified and allows shading elements to also be simulated.
For each Blender material that represents an Energyplus construction the “Create EnVi Nodes” button must be
pressed in the “VI-Suite Material” tab in Blender’s material properties panel. When this button is pressed a node
tree is created in the ’EnVi Material’ node editor with the name of the material. Material node trees can be selected
with the drop-down menu in the middle of the header bar of the “EnVi Materials” The node tree corresponding to
the currently selected material should be displayed with a single “EnVi Construction” node.

4.16.1 EnVi Construction node

The EnVi Construction node is the fundamental node for EnergyPlus construction specification and can be used
on its own to specify a construction from the VI-Suite’s internal database, or in combination with layer nodes to
define bespoke layers. Although this node is created automatically on the generation of an EnVi Material node tree,
additional construction nodes can be added via the ’Add > Type Node > Construction Node’ menu item in an EnVi
Material node tree. A basic construction node is shown in figure 45. This node has one input socket called “PV”
for the specification of PV modules, and an optional input socket called “Outer layer” if a layer based construction
specification is selected.
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. L . v EnVi Construction |l
Options within this node include:
. . . Active:
o Active - this construction node and and any :
linked layer nodes are the ones that define the Type: (window hd
EnergyPlus construction. This allows the quick Boundary: [ External v
switching between different construction setups. Air-flow: O
o Type - this sets the class of construction type, Proxy: [ Base v
which can be: Specification: [ Pre-set v
< Wall - opaque wall construction Simple glazing: )
o Floor - floor constructions that define the (DG - low-E - Krypton V)
zone floor area
_ Clear 3mm Soft LoE B0mm) [ mm 300 |
¢ Roof - roof constructions
. Krypton (14mm) [ mm 14.00 ]
© Window - openable transparent construc-
tion Clear 3mm (3.0mm) [ mm 3.00 ]
< Door - openable opaque construction Frame: [ Simple spec. V]
o Shading - shading surface Material: ( wood v)
© None - ignore this material % frame area: [ % 10.00 ]
o Boundary - this sets the boundary on the other
side of the construction, which can be: Figure 45: EnVi Construction node

o External - the conditions on the other side are ambient conditions (or ground in the case of a floor)
¢ Zone - the conditions on the other side is another zone’s conditions

¢ Thermal mass - if the type is wall, floor or roof, heat flow through the construction is ignored and is
purely a source of thermal mass for the associated zone.

o Airflow - this sets whether the surface allows air
to flow through it as part of a ventilation network

o Proxy - sets whether this is a proxy construction

¢ Base - this construction is not a proxy

< Copy - this construction is a copy of another construction
* Base material - sets the construction to copy

< Reverse - this construction is a reversed copy of another construction
* Base material - sets the construction to reverse copy

o Specification - specifies how the construction is
to be made up

o Pre-set - for the whole construction to be pulled from the current database
* This presents a drop-down menu to specify the database entry to be used:

- the thicknesses of each layer (mm) can then be set (numbers in brackets next to the database
entry label are sane numbers but the user can deviate from this)

* A U-Value calculation will be presented at the bottom
¢ Layers - to be made up of individual material layers. This exposes an input socket for the connection
of EnVi Layer nodes to make up the construction and presents the following options:
*« UV Calc - button to calculate the U-Value of the attached material layers (only valid for opaque
constructions)
* EC Calc - button to calculate the embodied carbon per unit area of the attached material layers

* Name - text entry field to set the name of this construction. If text is entered the following option
is presented:

- Save - saves this construction make-up to the current construction database
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4.16.2 EnVi Opaque Layer node

EnVi Opaque Layer nodes are added via the ’Add > Layer node > Opaque layer’ menu entry. The first of these
nodes attach to the “Outer layer” socket of the EnVi Construction node and subsequent layer nodes can then be
attached to the “Layer” input socket of previous opaque layer node. Only opaque layer nodes can attach to opaque
layer nodes.

Options with the opaque layer node are:

o Type - sets the type of material. ™ EnVi opaque layer l
o . . Layer
o Specification - sets whether the the material
properties are pulled from the internal database Type: ( Cladding v]
or defined with custom properties. Specification: ( Database V)
o If the specification is “Database” the fol- WEIEIEE (Praster board v
lowing options are presented: Thickness: [ mm 18.00 |
s Material - the database material. Embodied:
# Thickness - of the layer (mm). Embodied type: [ Cladding v]
o If the specification is “Custom” the follow- Embodied class: ( Plasterboard v)
Ing options are presented: Embodied material: [ Gyproc Standard ... v]
* Name - sets the name of the custom Service life: [ Years 30 )

material
.. L. id: Gyproc Standard plasterboard
s« Conductivity - thermal conductivity

(W/m.K) quantity: 1.0000

* Thickness - thickness of the layer (mm) unit: m2

# Roughness - surface roughness of the density: 1000.0000
material weight: 18.0000

+ Density - density of the material (kg/m?) T

s« SHC - specific heat capacity (j/’kg) eckai0 1188

s Therm absorb - infrared radiation ab-
modules: A1-A3

sorptance
* Solar absorb - solar radiation absorptance scima: 2.140
% Vis absorb - visible radiation absorptance ec/m2/y: 0.071
* Layer Save - if a custom name has been ? Layer

specified a save button is presented to
save the material to the internal data-

b Figure 46: EnVi opaque layer node (18mm plaster board
ase.

with embodied carbon)

o Embodied - a toggle to turn on embodied carbon calculation which presents the following options:
o Embodied class - selects the class of material

o If set to a non-custom material class the following options are presented:

* Embodied type - sets the type or sub-class of the material

* Embodied material - sets the actual material

* Service life - sets the service life of the material (years)

* A list of the stored database values associated with the material are presented. These include:
- ecdu - embodied carbon per declared unit
- eckg - embodied carbon per kg
- ec/m2 - embodied carbon per m? of surface area
- ec/m2/y - embodied carbon per m? of surface area per year of its service life
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o If set to Custom then the following options are presented:

*

¥ X ¥ ¥ ¥ ¥ ¥ ¥

Embodied id - text entry filed to set a unique id for the new database entry

Embodied class - text entry field to set the material class

Embodied type - text entry field to set the material type

Embodied name - text entry field to set the material name

Embodied modules - text entry field to set the embodied modules covered by this entry
Embodied unit - drop down menu to specify the type of declared unit

Embodied amount - numerical entry field set the amount of the declared unit considered

GWP per amount - Global Warming Potential per the declared amount

Embodied density - density of the material (an accurate value is only required if the declared unit
is m? or kg)

Service life - sets the useful service life of the material in years i.e. the number of years before the
material needs to be replaced.

Save - a button to save the material to the embodied carbon database (assumes all the above options
have valid entries)

4.16.3 EnVi Transparent Layer node

This node is similar to the above EnVi Opaque layer node but

details layers for glazing elements. This node connects, via
its “Layer” output socket, to the “Outer layer” input socket

 EnVi transparent layer

of a EnVi Construction node if the EnVi Construction node Layer
has the “Window” type. Subsequent layers can be added by Shade
connecting nodes to the “Layer” input socket of the previous
. Specification: [ Database v]
layer node. Only EnVi Gas layer nodes can connect to the
“Layer” input socket. An input and output “Shade” socket is Material: [ Clear 3mm v]
also provided for the connection of shading nodes. Options Thickness: [ o— 3.00 ]
presented within this node are:
Embodied:
o Specification - sets whether the the material properties e [ Glacs v]

are pulled from the internal database or defined with
custom properties.

o If the specification is “Database” the following

options are presented: Service life: y 20 |
s« Material - the database material. id: 2e7eabbd-df37-43ad-9062-2b8847c41de3
s Thickness - in mm. quantity: 1
o If the specification is “Custom” the following op- unit: kg

tions are presented:

3k

¥ ¥ X ¥ ¥ ¥ ¥

*

Embodied class:

Embodied material: general per kg v]

density: 2500
Name - sets the name of the custom material

weight: 1

Conductivity - thermal conductivity (W/m.K)

. . ecdu: 1.437
Thickness - thickness of the layer (mm)
STN - solar normal transmittance eckg: 1.437
FSN - Front-side solar normal reflectance modules: A1-A3
BSN - Back-side solar normal reflectance ec/m2: 21,555
VTN - visible normal transmittance ec/m2/y: 1.078
FVRN - Front-side visible normal reflect- T
ance

. . i Shade

BVRN - Front-side visible normal reflect-

ance
Figure 47: EnVi transparent layer (3mm glass)
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o ITN - infra-red normal transmittance

¢ FIE - front-side infra-red emissivity

* BIE - back-side infra-red emissivity

* Diffuse - whether this is a translucent rather than a transparent element

* Layer Save - if a custom name has been specified a save button is presented to save the material to

the internal database.

o Embodied - toggle to turn on embodied carbon calculation

© Options presented here are the same as for the EnVi Opaque layer node

4.16.4 EnVi Gas Layer node.

The EnVi Gas Layer node can be added with the “Add
> Layer Node > Gas layer” menu and creates gas layers
between the glazing layers of transparent constructions
and as such the “Layer” input and output sockets can
only, and both must, connect to EnVi Transparent Layer
nodes. The node has a “Specification” option where

{ v EnVi gas layer

database or custom can be chosen: Class:
o Database - gas characteristics are read from the Material:
current material database
Thickness:
¢ Air - air characteristics
o Argon - argon gas characteristics (8 Layer

¢ Krypton - krypton gas characteristics
¢ Xenon - xenon gas characteristics

¢ Thickness - thickness of the gas layer (mm)
o Custom

¢ Thickness - thickness of the gas layer (mm)
Coeff A - conductivity coefficient A (W/m.K)
Coeff B - conductivity coefficient B (W/m.K?)
Coeff C - conductivity coefficient C (W/m.K3)
Viscosity A - viscosity coefficient A (kg/m.s)
Viscosity B - viscosity coefficient A (kg/m.s.K?)
Viscosity C - viscosity coefficient A (kg/m.s.K?)
SHC A - specific heat capacity coefficient A
SHC B - specific heat capacity coefficient B
SHC C - specific heat capacity coefficient C
Mol Weight - molar weight

(IR R R R R EE e B IR B R

SHR - specific heat ratio

4.16.5 EnVi Shade node

Layer O

[ Database VJ

[ Air v]

[ mm 14.00 J

Figure 48: EnVi Gas layer node
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The EnVi Shade node can be added with the “Add > Shading
Node > Shading layer” menu and is designed to introduce
shading layers into layered, glazed constructions. The type
of shading layer represented by this node can only be used
once for a particular material and must connect via its input
“Shade” socket to the output “Shade” socket of the outer-
most EnVi Transparent layer node, or to the input “Shade”
socket of the innermost EnVi Transparent Layer. The node
also contains a “Shade” input socket for connection to the
“Shade” output socket of a EnVi Shade Control node.
Options in this node are:

o Solar trans. - solar transmittance

o Solar reflec. - solar reflection

o Vis. trans. - visible transmittance

o Vis. reflec. - visible reflectance

o IHE - infra-red hemispherical emissivity

o Intra. trans. - infra-red transmittance

o Thickness - shade thickness (mm)

o Conductivity - shade thermal conductivity (W/m.K)
o Glass distance - distance to glass layer (mm)

o Top mult. - top side opening multiplier

o Bottom mult. - bottom side opening multiplier
o Left mult. - left side opening multiplier

o Right mult. - right side opening multiplier

o Air perm. - air flow permeability

v EnVi shade

Solar trans.:
Solar reflec.:
Vis. trans.:
Vis. reflec.:
IHE:

Infra. trans.:
Thickness:

Conductivity:

Glass distance:

Top mult.:
Bottom mult.:
Left milt.:
Right mult.:

Air perm.:

Y Control

Shade l

0.05

0.30

0.05

0.30

0.90

0.00

mm

5.00

W/m.K

0.100

mm

50.00

0.50

0.50

0.50

0.50

NN Y Y

0.00

]
)
)
]
]
]
]
]
)
]
]
]
]
]

Figure 49: EnVi Shade node
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4.16.6 EnVi Blind node

The EnVi Blind node can be added with the “Add >
Shading Node > Blind layer” menu and integrates shad-
ing blinds into glazing constructions. The blind can be
placed externally, internally or between glazing layers
but only one is permitted per construction. The node
has an output and input “Shade” socket for connection
to an EnVi Transparent layer node “Shade” socket. The
node also has a “Control” input socket for connection
to a “Shade” output socket of an EnVi Shade Control
node.
Options in this node are:

o Slat orient. - slat orientation

¢ Horizontal - horizontal slats

¢ Vertical - vertical slats

o Slat width - width of the slats (this must be less
than the gas layer width if the blind sits between
glass layers)

o Slat sep. - separation between slats (this mush be
at least equal to slat width)

o Slat angle - angle of the slats (degrees)

o Slat cond. - thermal conductivity of the slats
(W/m.K)

o Slat beam trans. - slat beam transmission

o Front beam reflec. - front-side beam reflection
o Back beam reflec. - back side beam reflection

o Slat diff. trans. - slat diffuse transmission

o Front diff. reflec. - front-side diffuse reflectance
o Back diff. reflec. - back-side diffuse reflectace

o Slat beam vis. trans. - slat beam visible trans-
mission

o Front beam vis. reflec. - front-side beam visible
reflectance

o Back beam vis. reflec. - back-side visible reflectance

o Slat diff. vis. reflec. - slat diffuse visible reflectance

“ EnVi blind

Slat orient.:

Slat width:

Slat sep.:

Slat thick.:

Slat angle:

Slat cond.:

Slat beam trans.:
Front beam reflec.:
Back beam reflec.:
Slat diff. reflec.:
Front diff. reflec.:
Back diff. reflec.:

Slat beam vis. trans.:

Front beam vis. reflec.:

Back beam vis. reflec.:

Slat diff. vis. trans.:
Front diff. vis. reflec.:
Back diff. vis. reflec.:
Infra. trans.:

Front infra. emiss.:
Back infra. emiss.:
Glass dist.:

Top mult.:

Bottom mult.:

Left muit.:

Right mult.:

Min ang.:

Max ang.:

“® Shade
=@ Control

[Horizontal v]
[ mm 12.00 |
[ mm 20.00 |
([ mm 2.00 |
[ deg 45.00 |
[ wmk 10.00 |
( 0.00 ]
( 0.80 ]
( 0.80 ]
( 0.00 ]
( 0.80 ]
( 0.80 ]
( 0.00 ]
( 0.70 ]
( 0.70 ]
( 0.00 ]
( 0.70 ]
( 0.70 ]
( 0.00 ]
( 0.90 ]
( 0.90 ]
[ mm 50.00 |
( 0.00 ]
( 0.00 ]
( 0.50 ]
( 0.50 ]
( deg 0.00 |
[ deg 90.00 |

Figure 50: EnVi Blind node

o Front diff. vis. reflec. - front-side diffuse visible reflectance

o Back diff. vis. reflec. - back-side diffuse visible reflectance

o Infra. trans. - infra-red transmission
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o Front infra. emiss. - front-side infra-red emissivity

o Back infra. emiss. - back-side infra-red emissivity

o Glass dist. - distance between slat and window
o Top mult. - top side opening multiplier

o Bottom mult. - bottom side opening multiplie
o Left mult. - left side opening multiplier

o Right mult. - right side opening multiplier

o Min ang. - minimum slat angle

o Max ang. - maximum slat angle

4.16.7 EnVi Screen node

The EnVi Screen layer node can be added with the
“Add > Shading Nodes > Screen layer” menu and can
integrate an external shading screen into layered, glaz-
ing constructions. This node has an input “Shade”
socket for connection to the output “Shade” socket of
the outermost EnVi Transparency layer node (the con-
nected to an EnVi Construction node). The node also
has an input “Control” socket for connection to the out-
put “Control” socket of an EnVi Shade Control node.
This node has the following options:

o Reflected beam - sets the algorithm for reflected
beam solar:

o ModelAsDiffuse -
¢ ModelAsDirectBeam -
¢ DoNotModel -

o Diffuse reflectance - diffuse solar reflectance
o Visible reflectance - diffuse visible reflectance

o Thermal emissivity - thermal hemispherical
emissivity

o Conductivity - thermal conductivity

o Material spacing - screen material spacing (m)
o Material diameter - screen material diameter (m)
o Distance - screen to glass distance (m)

o Top mult. - top opening multiplier

o Bottom mult. - bottom opening multiplier

o Left mult. - left opening multiplier

o Right mult. - right opening multiplier

o Resolution angle - angle of resolution for output
map

Vv EnVi screen
Reflected beam:
Diffuse reflectance:

Visible reflectance:

Thermal emmisivity:

Conductivity:
Material spacing:
Material diameter:
Distance:

Top mult.:

Bottom mult.:

Left milt.:

Right mult.:
Resolution angle:

Shade

Control

ModelAsDirectB... v

0.50

0.60

0.90

W/m.K  0.100

mm 50.00

25.00

mm 25.00

0.00

0.00

0.00

0.00

0

[
[
[
[
[
[
(o
[
[
[
[
[
[

)
)
)
)
)
)
)
)
)
)
)
)
)

Figure 51: EnVi Screen node

Dr Ryan Southall

51

School of Architecture, Technology & Engineering




{
\{

Ay

VI-Suite v0.7 4 The VI-Suite Interface

4.16.8 EnVi Switchable node

This node represents a switchable glass layer that connects

to the input “Shade” socket of EnVi Transparent layer nodes 2SS IIE nl
via its output “Shade” socket. This node has the same op- Shade
tions as EnVi Transparent layer nodes - with the exception

of embodied properties which are not provided - and repres- Class: [ Database VJ

ents glass layer properties that will replace the glass layer
properties of the connected transparent layer node when the
schedule mandates. The node has one “Control” input socket Thickness: [ mm 6.00 J
for the connection of an EnVi Shade Control node to specify
the schedule.

Material: [ Clear 3mm v]

? Control

4.16.9 EnVi Shade Control node Figure 52: EnVi Screen node

This node specifies the schedule for shading nodes,
and has one “Control” output socket for connection to
the “Control” input socket of a shading node. Partic-
ular options within this node will also expose in input Control @
“Schedule” socket. This node creates an EnergyPlus
“WindowShadingControl” entity, and further details on
node options can be found in the relevant section of the
EnergyPlus Input Output reference document. Options
in this node are:

v EnVi shade control

Shading schedule: [ AlwaysOn v]

Figure 53: EnVi Shade Control node
o Shading schedule - sets the type of schedule:

© Many options are available. Some will require a schedule node and a “Schedule” input socket is exposed
for connection to an EnVi Schedule node when required.

& Some will require one or two set-points and options for these set-points are exposed.

4.16.10 EnViPV node

EnVi can now model the power output from PV pan-
els. The EnergyPlus simple, one-diode and San- :
dia representations of PV characteristics are all sup- v EnViPV A
ported. PVs are specified with the EnVi PV node, PV @
which can be added via the “Add > PV Node >

PV” menu entry. The node has one “PV” output

socket which should be attached to the “PV” input Area = 59.27m?2

socket of an EnVi Construction node. The node

also exposes input sockets: “PV Generator” which Heat transfer: [ Decoupled V]
Ipust be connected to a PV Generator ’node (§ec— Type: [ Simple v]
tion 4.16.11) and a “PV Schedule” which option-
ally should be connected to a schedule node (boolean PV area ratio: [ % 90.00 ]
type). o

Efficiency: [ % 2000 |

Options within this node include:
O PV Generator

o Area - and auto calculation of the building sur-
face area with this PV material applied (available O PV Schedule

after EnVi context export).
Figure 54: EnVi PV node

o Heat transfer - sets the thermal relationship between the panel and any construction with which it is associated
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¢ Decoupled - the PV panel has no thermal relationship
¢ (see EnergyPlus InputOutput reference manual for more details).

o Type - Simple, One-diode and Sandia PV power algorithms (see EnergyPlus Input Output reference document
for more details).

o If the simple type is selected options are:

o Proportion of the surface areas covered with actual PV cells.
¢ The conversion efficiency of the PV cells.

o If the One-diode type is chosen:

© Model - the database PV module model can be selected here or a custom module saved by specifying
the relevant parameters (see EnergyPlus InputOutput reference manual for more details).

o If the Sandia type is chosen then simple set the PV module model.

PV installations can either be incorporated into wall and roof constructions, or they can be stand-alone. For the
latter case the PV material is applied to a shading material.

4.16.11 EnVi PV Generator node

An EnVi PV Generator node is required to take the power from PV modules and make them available to the building
as standard AC voltage by the use of an inverter. This node plugs into the “PV Generator” input socket of a “PV”
node. At this time only a simple inverter model is implemented and so options here are:

o Efficiency - percentage efficiency of the inverter in converting DC from the PV panels to AC.

o Radiative fraction - the proportion of the power loss in conversion that is emitted as infrared radiation by the
inverter unit.

4.16.12 EnVi Schedule node

The EnVi Schedule node can be used to control when and in what proportion the PV panels and/or PV generator
produces power. If no node is specified it is assumed the PV system can produce power at any time. The schedule
node presents options in a similar manner to a general “EnVi Schedule” node with 0 as off, 1 as on or a value in
between for a proportion.

4.16.13 Copying materials

If you want to copy an existing EnVi material to change some of its properties, a particular process should be
followed. Create a new material slot for the object you wish to have the copied material. Select in this slot the
material you want to copy. Press the button immediately to the right on the material name window, which will
usually have a number displayed within it. This will create a copy of the material. Rename this material how you
wish and then recreate the material node tree by hitting the ’Create EnVi Nodes’ button in the *VI-Suite Material’
tab of the material.

4.17 FloVi Nodes
FloVi nodes control the stages of a CFD simulation with OpenFOAM.

4.17.1 FloVi Case node

The FloVi Case node can be added with the >Add > Process nodes > FloVi Case’ menu and creates the directory
structure and some of the high-level files required for an OpenFOAM simulation. The directory structure is created
within the “Openfoam/frame” directory in the project directory, where frame is the Blender frame being simulated.
This directory is known, in OpenFOAM terms, as the case folder, which means OpenFOAM binaries run from
within this folder will find all the information they need to run the simulation.
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The node contains one “Case out” socket for connection
to a FloVi Netgen node “Case in” socket and contains the
following context sensitive options:

o Scenario - this sets a general simulation context which
can filter the choice of available boundary conditions:

o External flow - focused on wind-driven flow
around buildings
¢ Internal flow - focused on flow within buildings

¢ Forced convection - focused on forced flows with
temperature simulation

o Free convection - focused on free convective
flows

¢ Custom - all OpenFOAM boundary conditions
made available by the VI-Suite can be used

[¢]

Parametric - sets a parametric analysis:

¢ Frames - start and end frame for a parametric ana-
lysis

o

o

[¢]

Vv FloVi Case

Scenrio:
Parametric:

Time step:

End time:

Write interval:

Field pressure:
Reference pressure:

Field k (0.375):

Field epsilon (0.004):

Field nut:

Field velocity type:

-—

Field velocity: [ X 0m/s [ Y 5ms [ Z omys

Case out O
[ External flow v]
U
( 2.0000 )
( 2000.00 )
( 100 ]
( 0.00 )
[ None v]
( 0.375 )
( 0.004 ]
( 0.00 )
[ Vector v]
J
)
J
J
J

p Residual: ( 0.000100
U Residual: ( 0.000100
k/epsilon Residual: [ 0.000100
[ Export

Figure 55: FloVi Case node

Time step - the false time step for a steady-state simulation (seconds)
End time - the end false time for a steady-state simulation (seconds)

Write interval - the false time step interval for the writing out of results

o Buoyancy - whether heat transfer is to be modelled (only presented if scenario is “Custom”, “Forced con-
vection” or “Free convection” and is mandatory for the latter two)

o Comfort - whether to calculate PPD and PMV comfort metrics

* Clothing - clothing level in clo
* Metabolic - metabolic rate in met
* Humidity - relative humidity in %

o Age - whether to calculate age of air

< Radiation - whether to include radiation calculations

s Rad model - sets the radiation model
- P1 - uses a p1 radiation model

- fvDOM - uses a fvDOM radiation model

* Field radiation - sets the initial field radiation value

s Field I - sets the initial field I value for the fvDOM radiation model

¢ Field p_rgh - initial field p_rgh value
¢ Field alphat - initial field alphat value

o Field pressure - initial pressure within the domain

o Reference pressure - if a reference pressure value is required this sets the type:

© None - no reference pressure point is provided

¢ Relative - a relative pressure point is provided

* Ref. pressure value - relative pressure value in Pascals
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* Pressure point - list of Blender empties that provide the location of the reference pressure location

¢ Absolute - an absolute pressure point is provided

* Ref. pressure value - absolute pressure value in Pascals

* Pressure point - list of Blender empties that provide the location of the reference pressure location

o Field velocity type - the initial domain velocity type:

o Vector - set an XYZ vector for flow direction

* X, Y & Z flow vector components (m/s)

o Azimuth - set an azimuth (degrees clockwise from +Y North) and speed (m/s)

* Field flow azi. - azimuth angle (degree)
* Field flow speed - flow speed (m/s)

o Field k - initial domain k value (number in brackets represents a suggested value based on field velocity)

o Filed epsilon - initial domain epsilon value (number in brackets represents a suggested value based on field

velocity)
o Field nut - initial domain nut value
o p Residual - terminating pressure residual

o U Residual - terminating velocity residual

o k/epsilon Residual - terminating k and epsilon residual

FloVI Case node should be exported once the geometry and general material specification has been created. The
node should also be re-exported if any changes are made to sensing probes, a material name or a boundary condition

changes class e.g. from Patch to Wall.

4.17.2 FloVi Netgen node

The FloVi Netgen node can be added with the >Add > Pro-
cess nodes > FloVi Netgen’ menu and controls computa-
tional mesh generation with Netgen (https://ngsolve.org/).
Netgen produces tetrahedral meshes which can be con-
verted in polyhedral meshes with OpenFOAM. This node
has one input socket “Case in” for connection to a “FloVi
Case” “case out” socket and one output socket “Mesh
out” for connection to a “FloVi Boundary” “Mesh in”
socket. Upon pressing “Generate” the mesh will be
constructed and, all being well, a visualising mesh will
be created in Blender in the “FloVi Geometry” collec-
tion.

Options within this node include:

o Cell size - this sets the maximum cell size for the over-
all domain

o Position corr - this sets the maximum distance differ-
ence for a Blender face material to be associated with a
computational mesh face (this may need to be lowered
if dealing with a very small domain)

Vv FloVi NetGen

Cell size:

Position corr:
Angular corr:
Distinction angle:
Inflation:
Optimisations:
Attempts:

Polygonal:

e

Mesh out O

1.00
m 0.10

deg 1.00
0.30

w |l w
(<]

[ Generate

(N

? Case in

Figure 56: FloVi Netgen node
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o Angular corr - this sets the maximum angular difference for a Blender face material to be associated with a
computational mesh face

o Distinction angle - this sets the angle between geometry faces that will force Netgen to consider the separating
edge a mesh boundary

o Inflation - controls the rate at which smaller localised cells take on the size of the domain (smaller value leads
to a more gradual cell size change)

o Optimisations - controls the number of optimisations steps for the meshing algorithm

o Attempts - sets the number of attempts

o Polygonal - controls whether OpenFOAM should be used to generate a polygonal mesh
The node should be re-exported if changes are made to the simulation geometry, a material name or material class
specification is changed e.g. Patch to Wall.
4.17.3 FloVi Boundary node

Thie “FloVi Boundary” node can be added with the “Add > Pro-
cess nodes” menu and takes the FloVi boundary parameters set within

Vv FloVi Bounda
Blender’s Material properties panel and writes out the requisite Open- v 8

FOAM boundary specifications. The node contains one input “Mesh Context out ©
in” socket for connection to the “Mesh out” socket of a “FloVi Netgen”

node, and one output “Context out” socket for connection to the “Context [ Generate J
in” socket of a “FloVi Simulation” node. Upon pressing the “Generate” © Meshin

button boundary specifications will be written to the case directory.
The node should be re-exported if any material name or specific ] .
boundary condition options change. Figure 57: FloVi Boundary node

4.17.4 FloVi Simulation node

The “FloVi Simulation” node can be added with the *Add > Simula-
tion nodes > FloVi Simulation’ menu and runs the OpenFOAM simu-

. . . . . Vv FloVi Simulation -\
lation. The node contains one input “Context in” socket for connection Y
to a FloVi Boundary node “Context out” socket, and one output “Res- VI results ©
ults out” socket for connection to a VI Metrics or VI CSV node. Probes
will need to be set-up within the flow domain for results to be avail- Processes:
able. Paraview: ()
Options here are: { Calculate }
o Processes - splits the mesh into the set number of chunks for paral- (e Contextin
lel computation (this can be ultimately slower on OS X and Win-
dows as OpenFOAM is run from a Docker image) Figure 58: FloVi Simulation node

o Paraview - opens Paraview for results visualisation (linux only)
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The following section detail some of the analyses that can be done with the VI-Suite.

5.1

Sun Path Projection

Projecting a sun-path analysis into the Blender scene

requires a “VI Location” node to be created to

provide the latitude and longitude co-ordinates of

the scene. The “VI Location” node can either take
the latitude and longitude values from an EPW file,

Source:

Weather file:

Location out Suns:

EPW

GBR - LONDON/GATWICK v

Single v

O Location in

or they can be entered manually. Once the location
node has been set-up a “VI Sun Path” node can be
created and the "Location out" socket of the location
node dragged to the "Location in" socket of the “VI Sun Path” node. A typical node set-up is shown in figure 59.

The Sun Path node itself has one menu option to set the number of suns created, and a button to be clicked to
create the sun-path. The created sun path with have a Blender object base and Blender lights to represent the suns
along with OpenGL overlays of the sun paths. The entire sun path references the base, which as a regular Blender
object (called spathMesh) can be rotated, scaled and moved, and doing this will manipulate the entire sun path. The
sun path base object spathMesh has materials associated with it and these can be changed to alter the appearance
of the sun path. Once a sun-path has been created a number of options are presented with the 3D view port sidebar
in the "VI-Suite Display" tab (section 4.10.3). The sun path display options available are shown in figure 60.

The options in this panel are:

(¢]

Lighting - sets the way Blender’s solid view mode is lit. Flat
is recommended for sun path shadowing (solid mode shad-
owing is turned on in the solid mode shading menu).

Latitude - allows the changing of the latitude location for the
sun path

Longitude - allows the changing of the longitude location for
the sun path

Day of year - if a single or hourly sun set has been created
this option sets the day of the year for the sun position(s)

Time of day - if a single or monthly sun set has been created
this option sets the time of day for the sun position(s)

Sun strength - in solid shading mode, if shadows are turned
on, this options sets the depth of the shadows. If in Cycles
rendered mode this sets the strength of the sun(s). This op-
tion is useful to get the right level of shadows.

Sun angle - in Cycles rendered mode this sets the sharpness
of the shadows.

Line width - sets the width of the sun path lines (does not
work on OS X).

Solstice colour - sets the colour of the solstice lines.
Hour main colour - sets the main colour fr the hour lines.
Hour dash colour - sets the dash colour of the hour lines.

Hour dash ratio - sets the size of the hour line dashes.

¥ VI Display

Figure 59: Sun Path node set-up

Lighting: [ Flat

Latitude:
Longitude:

Day of year: 15/8
Time of day: 18:5
Sun strength:
Sun angle:

Line width:
Solstice colour:
Hour main colour:
Hour dash colour:

Hour dash ratio:

Hour dash density:

Sun size:

Sun colour:
Globe colour:
Display time:
Display hours:
Font size:

Font colour:
Font shadow:
Shadow colour:

Display active

51.15
-0.18
227
18.09
2.17

0.01

{ Laser Jl VI-Suite H TechSec Jl View HlmH Item]

0.50
1.00

16

| R

Figure 60: Sun Path visualisation options
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o Hour dash density - sets the ratio of dash to hour line.

o Sun size - sets the size of the OpenGL sun overlay.
o Sun colour - sets the colour of the OpenGL sun overlay.
o Globe colour - sets the colour of the sun path sphere.

o Display time - displays the date, time, solar azimuth and altitude next to the sun if a single sun has been
created.

o Display hours - displays the time in hours at the top and bottom of the hour lines.
o Font size - size of the font of any numerical/text display.

o Font colour - main font colour.

o Font shadow - turns on font shadowing.

o Shadow colour - changes the colour of the font shadow colour.

o Display active - turn this off to deactivate visualisation (this should be turned off when finished with the
visualisation).

For the sun path analysis the choice of suns requires certain rendering modes for optimal operation. If a single sun
is chosen then shadowing analysis can be achieved with the solid viewpoint rendering mode. If multiple suns are
selected then shadowing can only be visualised in view port rendering mode, preferably with the Cycles rendering
engine. In rendered mode, parameters such as sun strength and sky colour are important to achieve the right balance
of light and shadow.

5.2 Wind Rose Projection

Type: Cont 2 v

Start day 1/1: [ 1 ]

End day 31/12: 365 ]

Colour: Rainbow M

Location out [
Max frequency: Data v
Source: EPW v Create Wind Rose ‘
Weather file: GBR - LONDON/GATWICK v Location in

Figure 61: Wind Rose node set-up

Projecting a wind rose into the scene requires a “VI Location” node and a “VI Wind Rose” node, that latter of which
can be added with the “Add > Analysis Nodes” menu.

In this case the location node provides wind speed
and direction data for the wind rose analysis and there-
fore an EPW file must be chosen as the source of in-
formation within the location node. A typical node set-
up is shown in figure 61.

The options within the wind rose node control the  «
type of wind rose plot to create (two types of histogram
and three types of contour plot are available), the start
and end days of the year to plot and the colour scale to
use for the plot. Examples of a histogram and contour
plot are shown in figure 62.

Figure 62: Histogram and contour wind roses
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Once the button to create a wind rose is pressed a v Vi Display =
wind rose object is created at the centre of the scene. | Q
This object, like any Blender object, can be moved, S E
scaled and re-sized as desired. Each time the wind rose
button is pressed a new object is created. e g

When a wind rose object has been created a “Wind e M
Metric” button is exposed in the "VI-Suite Display" in: %
tab (section 4.10.3) of the 3D view properties panel. Refresh: oC
Once this button is pressed 2 icons will appear in the Display active E
3D view: A "Legend" icon to display the wind speed =
legend for the wind rose, a “Table” icon to display tab- ‘ ‘ ‘ Fl

i

ulated wind speed and direction data. The data dis- N ‘ ‘ ‘ ‘
played in the table is extracted from the currently se-
lected wind rose object.

The scatter graph options present in version 0.6
have been replaced by the VI Heatmap node.

Figure 63: Wind metric display options

5.3 Shadow Mapping

A shadow map study requires a VI Location node to
provide just the latitude and longitude co-ordinates of

v Vi srpadow Map

the site, so either an EPW file or manual entry can sup- Results out
ply this data, and a VI Shadow Map node. A typical Ighore sensan a
node set-up is shown in figure 64. P Static .

A shadow study analysis requires geometry to act as swrtaayi1 | 1|
shadowers, and sensing geometry to measure the level b S s
of shadow. Blender mesh geometry will by default act swrthow: [ 10
as a shadower and requires no particular setting to do o G
so as long as it is visible in the 3D viewport. Sens-  ‘evitocation © Hoursteps: (1|
ing geometry is specified via its material designation. Location out Resultpoint: | Faces -
Once a Blender object has a material associated withit . =~ = — T on
(and this material can only be associated with specific Lattude [ 5245 ) [ Calculate l
faces of an object if desired) then in the Blender mater- longtude [ 175 ) 5 Locationin

ial properties panel in the VI-Suite Material sub-panel
there is an drop-down menu called "Material type".
Within this menu the option "Light sensor" should be
selected. It should be noted that sensor geometry senses in the direction of the normals of the geometry. You can
check normal direction in Blender’s mesh edit mode. If normals point in the wrong direction “flip” the normals, or
rotate the object so they face in the desired direction.

The year period for the simulation is set within the VI Shadow Map node with the start month and end month
options. The period of each day to be simulated is set with the start hour and end hour options. The "Hour steps"
option sets the hourly time step for the simulation. A value of 1 will do a calculation once per hour, and a value of
4 will do 4 per hour. The "Animation" option allows either a static analysis or one based on a geometry animation.
If "Static" is selected then results are valid for the current selected frame. If "Animated" is selected results will be
generated for each frame of the created animation.

Once a simulation has been completed, some simulation metrics will be written to the vi-suite-log file and in the
3D viewport sidebar (section 4.10.3) the VI-Suite Display sub-panel will present a shadow study display button.
Once this is pressed results will be plotted on the sensing geometry with a user defined colouration, signifying how
often that point receives direct sunlight, when the sun is above the horizon, for the specified simulation period. The
display panel options are shown in figure 65. In the 3D viewport, an icon will be displayed in the upper left corner.
Clicking on this will open up a legend display relating colour to numerical value.

Figure 64: Shadow Map node set-up
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The options in the display panel are:

e}

o

VI 3D Display - If selected before the display button
is pressed the results can be extruded to provide 3D
result visualisation.

Shadow Display button - When clicked will initiate
display and expose further display options.

Result type - sets the metric (% sunlit is the only rel-
evant metric here)

Legend unit - a string entry box to replace the legend
unit title

Processing - modifies the results or their visualisation

¢ None - no modification
© Modifier - a constant result modifier

¢ Script - a Python scripted result and/or visualisa-
tion modifier

Modifier - if modifier was selected in the previous op-
tion this string entry box can scale modify the results
(*100 would multiply results by 100, /100 would di-
vide by 100)

Script - If script was chosen as the processing option
than a selection box is presented to pick a Blender text
file containing the python script.

¥ VI Display
Result type:
Legend unit:
Processing:
Modifier:

Frame:

Legend max:
Legend min:
Legend scale:
Legend colour:
Legend levels:
Emitter materials:
Emitter strength:
Draw wire:
Transparency

Point visualisation

% Sunlit

Modifier

100.00

Linear

Rainbow

l Laser“ VI-5uite “ TechSec “ View H Tool “ Item‘

rJ
(=]

o
‘ ‘ < < < <

1.0

1.00

Enable: O
Refresh: O
Display active

Figure 65: Shadow study display options

Frame - Either shows the frame that a static analysis was conducted on, or allows the picking of the frame of

a parametric analysis

Legend max - allows the changing on the max value of the legend scale.

Legend min - allows the changing of the min value of the legend scale.

Legend scale - sets the legend scale to linear or logarithmic.

Legend colour - sets the colour of the legend and geometry colouration.

Legend levels - sets the number of colour divisions of the legend and geometry colouration.

Emitter materials - makes the Blender materials ignore any lighting (useful for Cycles rendered mode).

Emitter strength - emission strength of emitter materials

Draw wire - draws a wireframe over the selected result visualisation geometry

3D Level - If “VI 3D Display” was selected this number will extrude the results plane for 3D results visual-

isation.

Transparency - sets the transparency of the result geometry

In the Point Visualisation section:

o Enable - Turns on per-point numerical visualisation of the results
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o Selected only - Only the currently selected object will display numerical results
o Visible only - Only points not obscured in the 3D view show numerical results
o Font size, font colour, font shadow - changes the colour and size of the point numeric font.

Some additional metrics can be viewable by the use of the Modifier and Legend unit options. For example, after
simulation in the vi-suite-log file will be written the total number of hours over the simulated period where the sun
was above the horizon.

The node contains one output “Results out” socket which can connect to a VI Chart, VI CSV or VI Heatmap
node for data visualisation/export. Figure 66 shows a shadow study analysis of the terrain around Mount Snowdon.

Figure 66: Shadow study analysis of Mount Snowdon

5.4 Sky View Factor

A sky view factor (SVF) analysis requires only a “VI SVF” node available in the “Add > Analysis Nodes” menu.
The node is described in section 21. The process of setting up the simulation is very similar to the shadow mapping
process in that Blender geometry with a “Light Sensor” material associated with it will act as the sensing geometry
according to the sub-divisions of the geometry. Once the “Sky View Factor” button in the “VI SVF” node has been
pressed the calculation will proceed and when finished a “Sky View Display” button will appear in the “VI-Suite”
tab of the 3D viewport sidebar. Pressing this will create visualisation geometry in the “LiVi Results” collection and
present options similar to those described in the shadow mapping section(5.3). The “Results out” socket of the “VI
SVF” node can be connected to the “VI CSV” or “VI Chart” node for export/visualisation.

5.5 Embodied Carbon Analysis

This section covers the stand-alone calculation of Embodied Carbon with the VI Embodied Carbon node (section
4.12.5). In this stand-alone analysis, the volume or area of Blender mesh objects is converted into an embodied
carbon figure based on the embodied carbon data associated with the object. This process therefore requires two
things: Blender objects and embodied carbon data associated with these objects.

In terms of objects, it is important that the objects modelled are appropriate for the embodied carbon calculation.
If the embodied carbon data associated object has a declared unit of m?3, or kg then the object must represent a
coherent volume, and ideally be manifold i.e. all edges have two faces associated with them and normals are
consistent. A plane therefore would for example not be acceptable. If the declared unit is m?, then it is the area of
all the faces of the object’s mesh that will be used in the embodied carbon calculation. If the declared unit is “Unit”
then one object is assumed to be one unit, irrespective of mesh characteristics.

The next thing that is required is appropriate embodied carbon data associated with the objects. This is done
within the VI-Suite Object sub-panel in Blender’s Object properties panel. By toggling on the ’Embodied’ option,
further options will appear (figure 67) to either call up the the data from the current database, or to specify a new
data entry based on a manufacturer’s EPD file.
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Options for calling up a database entry are:

v VI-Suite Object
o Embodied class - the class of material.

o Embodied type - the sub-class of material. [ None v]

. . . -- Octr: neration --
o Embodied material - the actual material. Octree generatio

o Service life - the expected service life before re- Triangulate: D
placement in years. Mesh:
When a database entry has been selected, some inform- [ Generate Octree ]
ation about that database entry is also presented to the
user: Embodied:
o id - unique identifier for the entry Embodied class: [ Aluminium "]
o quantity - amount of the declared unit considered Embodied type: [ sheet "]
o unit - type of declared unit Embodied material: [ sheet worldwide v]
o density - density of the material (kg/m?) Service life: [ y 60 ]
o WEight - the WEight of the quantity of the de- id: 7c7cb7bb-2c99-45¢c1-9faf-b243fe91211d

clared unit quantity: 1.0000

o ecdu - embodied carbon (kgCO-e) per declared unit: kg
quantity
density: 2750.0000
o eckg - embodied carbon (kgCOse) per kg of ma- Y

terial weight: 1.0000

o modules - the embodied carbon modules covered ecdu: 12.9559

by the declaration
eckg: 12.9559

A database entry can be edited by pressing the “Edit”

button at the bottom. This will present dialogue boxes modules: A1-A3

showing the current materials characteristics. These [ Edit ]
can be changed and the “Save” button used to update
the database entry if the “Embodied id” option is not
changed. If it is changed a new material is created. It
is only recommended to edit entries the user has previ-
ously added, as the database that comes with the VI-Suite is based on the ICE database.

If “Custom” is chosen for Embodied class option, then entries are again editable. If the “Embodied id” option
is changed a new material will be created. If not the current id entry will be updated.

Once objects and their embodied carbon characteristics have been set an embodied carbon calculation can be
done using the VI Embodied Carbon node (section 4.12.5). Create this node select appropriate options, and press
the “Calculate” button. Upon completion results are written to the node which can be accessed via the VI CSV
node and VI Metrics node.

The VI Metrics node type should be set to “Embodied carbon” and will display embodied carbon metrics for
the chosen object/collection for the chosen frame and will present a “Pie chart” button to display a pie chart (figure
68) of the embodied carbon results (please not that objects or collections with a negative embodied carbon will not
display in the pie chart).

If an animated simulation was conducted frame based results can also be visualised with the VI Chart node.

Figure 67: VI-Suite Embodied carbon object properties
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Structure
285029.8 kgCOe

Total kgCO,e

801588.2
Total kgCO,e/m? Claddi
166315 — o
Total kgCO,e/m?/y

267.2

Insulation /
506637.9 kgCO,e

Figure 68: Embodied carbon pie chart

5.6 LiViLighting Analysis

Lighting analysis is conducted with the LiVi component of the VI-Suite, which acts as a pre/post processor for the
Radiance software simulation suite.

The main LiVi nodes are: LiVi Geometry (section 4.13.1), LiVi Context (section 4.13.2), LiVi Simulation
(section 4.13.3), LiVi Image (section 4.13.4), LiVi Glare (section 4.13.5) and LiVi FC (section 4.13.6). All are
detailed in section 4.13. A basic LiVi analysis will require VI Location, LiVi Geometry, LiVi Context and LiVi
Simulation nodes.

A numerical LiVi lighting analysis, like a shadow study, requires geometry within the scene to be identified as
sensing geometry. This is done in the material panel within the Vi-Suite Material sub-panel where the option "Light
Sensor" should be selected in the "Material type" drop-down list. All geometry to which this material is associated
will now act as a sensing surface. Sensing surfaces are not required for glare studies, image production or if only
a preview of the Radiance scene is to be conducted. The sensing geometry senses in the direction of the Blender
mesh face or vertex normals.

5.6.1 LiVi Geometry

The LiVi Geometry node (section 4.13.1), which can be found in the "Add > Process Nodes" menu of the Vi-Suite
Nodes editor, controls the export of the of the Blender scene geometry and materiality to the Radiance text file
format. Any Blender geometry that is not hidden, and has materials associated with Radiance material descriptions,
will be exported unless the object or material has a “/” in the name. Radiance material specifications are set in the
VI-Suite Material properties sub-panel, details of which can be found in section 4.10.2.

Upon pressing the node’s "Export" button the node first converts Blender materials to Radiance material de-
scriptions. Next, suitable geometry is exported. If the "Mesh’ option in the LiVi Geometry node is selected, then
obj files are saved to the "obj" folder created in the project directory and automatically converted to Radiance mesh
files, with Radiance’s obj2mesh program. This is required for Radiance patterns and textures (see below) to be ap-
plied. If the “Mesh” option is not selected, actual object vertex co-ordinates are instead written out to the Radiance
input and is generally a bit quicker when simulating.

Next Blender lights are exported to Radiance format. There are two ways to set-up lights for Radiance export:
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creating standard Blender lamps, or creating a plane at each face of which a lamp is automatically specified by
giving the mesh the “Light Array” type in the VI-Suite Object sub-panel. If using the first method then selecting
a lamp within Blender will display in the VI-Suite Object sub-panel some IES specific options. In this section it
is possible to specify an IES file to associate with the Blender lamp. IES files are released by luminaire and lamp
manufacturers, and describe the brightness of a luminaire or lamp from multiple directions. The desired IES can
be picked with the "Select IES File" button. Some additional options are also presented:

o IES Dimension - specifies the distance unit for the geometry described in the file
o IES Strength - which allows the light to be dimmed (can be animated)
o IES Colour - sets the colour of the lamp (can also be animated).

o RGB - sets the RGB colour of the lamp

< Temperature - sets the colour temperature of the lamp

The second method allows any selected mesh object to have an IES file associated with it via the VI-Suite Object
sub-panel by selecting “Light Array” as the object type. Any IES file selected here will now be applied in the
Radiance scene at each face centre of the mesh object. This is useful for quickly setting up arrays of lights. Simple
rotations of the light array object will be reflected in the positioning and direction of the lights in the Radiance
scene, although more complex rotations may not be correctly reported to Radiance. In general keep IES object
rotations to a single axis rotation.

If undertaking an animated, parametric analysis LiVi will export Radiance geometry and materiality for each
frame from start frame to end frame as specified within the LiVi Geometry node interface. How to set up animations
in Blender is beyond the scope of this document so please refer to on-line information for this but in short pressing
the ’i’ key with the cursor over the value in the interface to be animated will register that value for the current
animation frame selected.

Radiance Patterns & Textures For certain Radiance material types there is also a “Texture image” option avail-
able in the VI-Suite Material sub-panel. This allows the application of an image already loaded into Blender to
the geometry as a Radiance pattern. To apply the Radiance pattern the “Mesh” export option must be turned on in
the LiVi Geometry node. The image will also have to be UV Mapped to the Blender geometry in Blender’s UV
Editor to provide the positional relationship between the image and the geometry. As the image acts as a modifier
to the base Radiance material, the base material should have a white colour to apply an unmodified image within a
Radiance simulation.

(a) Texture map (Radiance pattern) (b) Normal map (Radiance texture) (c) Blend map (texture with white background)

Figure 69: Radiance image based materials

Radiance textures can be also be applied - assuming no blend map (see below) has been selected - based on
the Blender image selected in the “Normal map” option in the VI-Suite Material sub-panel. If the material has a
texture image that has already been UV mapped to Blender’s geometry this image does not need to be UV mapped.
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Additional options are also exposed for the directions in Blender world co-ordinates of the colours within the normal
map image when applied to the planar surface in Blender, and the strength of the normal perturbation effect. These
options mean that each material texture map only works correctly for surfaces with the same orientation.

Blend maps can also be applied to the material if a normal map has not been applied. This Blender image should
be a black and white image where the white pixels will expose the current material, and black will either be the
background material selected below, or transparent if no background material is selected. This image should be
UV mapped to Blender geometry if no other image has already been UV mapped.

For either patterns or textures to work when producing Radiance images with the LiVi Image node, the “Illu-
minance” option within that node should be turned off.

Radiance Instancing Radiance instances can be im-
plemented by using Blender’s particle system. In- W Plane > I ParticleSystem <
stances allow many complex objects to be positioned

.-
=l

within the scene in a memory efficient way, and by us- A

ing Blender’s particle system, the positioning, rotation =

and size of these objects can be randomised. This can w .

lS)i(; ;lseeglelemrfr}llsgéfor example, creating a forest with a N (T Partdesettings 008 o |
To create instances a mesh object is required as a & | Emiter

substrate for the instances e.g. a ground plane, and an- () Regrow 4 Advanced

other mesh object is required to be instanced e.g. a tree. v Bl

The instance object should have Radiance materials as- @ Number | 193 )

sociated with it. A Blender particle system should be seed | = ]

created on the substrate object using the Particle Prop- HairLength | — ]

erties panel (figure 70). Within this panel The “Hair” Segmens S ] .

option should be selected and the “Advanced” toggle

selected. In the “Emission” sub-panel the “Number” ™ Source

option sets the overall number of instances available., Emit From [ Vertices v

and “Hair length” will scale the size of the instances. (O use Modifier Stack .

In The “Source” section, the “Emit from” option sets
whether instances are associated with the faces or the
vertices of the substrate geometry. If “Face” is selected

(CJ random Order

> (JHair Dynamics

then if “Distribution” is set to “jittered” then the num- 2 Valecity
ber of instance objects per face can be set with the “In- ~ [@Rotation
stance/Face” option. The “Emission > Number” option E Orientation Axis [ Global Z )
should then be set to the number of faces multiplied by Randomize | 0.000 ) -
the “Particles/Face” option. If “Vertices” is selected in rose (NS ) -
the “Emit from” option option the “Emission > Num- Rendomize phase (L] 099 ) -
ber” option should be set to the number of vertices if
one instance per vertex is required. > Angular Velocity

By activating the “Rotation” sub-panel, the axis of > Physics
rotation can be set the “Orientation Axis” option, which ¥ Qenplr
should be set to “Global Z” on the level of rotation and
randomness of the rotation can be set with the “Phase” Render s [ Otjec -

. ! .54 .
and “Phase” randomness options. ccole Rand scale iﬁ
. . Cale Randomness .
In the “Render” sub-panel select “Object” in the

“Render As” option and set the “Scale”, which is multi-

(J show Emitter .
plied with “Hair length”, to generate an overall instance
size and “Scale Randomness” to randomise size. In the > Object
“Object” section select the instance object in the “In- Instance Object [ Suzanne x
stance Object” options and turn on “Global Coordin- & Global Coordinates .
ates”, “Object Rotation” and “Object Scale™. (@ obiject Rotation .
Object Scale .

Figure 70: Blender Particle Properties panel
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Radiance BSDFs It is possible to generate BSDFs with Radiance for use with simulation in the VI-Suite. BSDFs
are useful when considering the repeating arrays of geometry that constitute a complex fenestration system (CFS)
and a BSDF can be generated for one element of the repeating array.

To generate a BSDF a Blender object is required that represents the geometry for which a BSDF is to be
calculated. This object should have Radiance material properties associated with it, and the object itself should be
identified as “Complex Fenestration” in the Blender object properties panel in the VI-Suite Object sub-panel. The
size and position of the object does not matter as the VI-Suite does not currently support the inclusion of geometry
into the BSDF, and the VI-Suite automatically moves and rotates the geometry to be suitable for BSDF generation.
Other rules on generating BSDFs with Radiance should however still be respected (see the genBSDF manual for
details).

The object requires one mesh face that has the BSDF Radiance material specification. This face is not part of
the BSDF calculation itself, and can be created by copying an existing mesh face of the object, but it does serve
two other functions: it is the material associated with this face within which the BSDF data will be stored, and the
normal of the face must point into the room or towards the camera ray direction. The face should also be positioned
inline with the internal face of the object.

Options for the BSDF material applied include:

Incoming

o Proxy depth - not used during BSDF generation
but important for the application of the BSDF
material in a simulation.

o Up vector - this sets the up in Blender world co-
ordinates direction for the BSDF during genera-
tion and application

o Load BSDF - an existing BSDF file can be
loaded into this material

o Delete BSDF - a BSDF description associated
with this material is removed Visible Transmission Back

o Save BSDF - saves the associated BSDF descrip-
tion to file

—
o

Once the setting for the BSDF material are as required,
and the in the Blender object properties panel the object
has been set to “Complex Fenestration”, more options
should appear for actual BSDF generation. These in-
clude:

-

Percentage of incoming flux (%)

=
-

o Direction - sets the direction for the sample rays:

¢ backwards - from camera ray direction

o forwards - to camera ray direction

¢ bi-directional - both to and from camera ray Figure 71: Example BSDF visualisation

direction

o Klems/Tensor - whether a Klems or Tensor Tree BSDF should be generated

¢ Klems - standard BSDF sub-division (only this kind can be visualised within the VI-Suite)
© Symmetric - Tensor standard sub-division

¢ Asymmetric - advanced asymmetric Tensor sub-division

o Samples - number of samples per direction
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o RC params - text box for custom rcontrib parameters

Once these settings are as desired the “Generate BSDF” button can be clicked and the BSDF will be created. A
Kivy window will pop up although this window cannot give a prediction of time remaining for BSDF calculations.
Pressing the “Cancel” button will kill BSDF generation if the Python psutil package is available. If not, rcontrib
processes must be killed manually. Bear in mind that BSDF generation with high sample numbers can take a long
time.

Once completed, the BSDF information is stored within the Blender material, and can now be applied to Blender
geometry for simulation. Any geometry that is to have the BSDF applied must have it’s normal also pointing
inwards, or towards the camera ray direction.

The “Proxy Depth” of the material can now be used. If the proxy depth is zero, all incoming light will be
processed via the BSDF. If the proxy depth is more than zero any valid Radiance geometry within that depth will
deal with direct light calculation and the BSDF with diffuse. This can be done using Blender instances for memory
efficiency. If no geometry is specified direct light will pass straight through the BSDF. The “Up Vector” should
also be set to the up direction of the geometry to which the BSDF material is applied.

If a Klems BSDF has been generated, the BSDF can be visualised with the VI-Suite. Selecting the original
complex fenestration object, and selecting the BSDF material within that object, should display a “BSDF Display”
button in the VI Display section of the VI-Suite tab in the 3D view port sidebar. Clicking this button will create
an icon in the upper left of the 3D view port. Clicking on this will display two Klems distributions: the upper one
can be clicked on to select the incoming light direction and the bottom one displays the outgoing light percentage
distribution. Options are also displayed in the VI-Suite display tab that include:

o Direction - sets the direction for visualisation

o BSDF max/min - sets the legend maximum and minimum values

o

BSDF scale - linear or logarithmic legend scale

o

BSDF colour - sets the legend and BSDF colouration

o

Display active - this should be turned off after visualisation

5.6.2 LiVi Basic analysis

A basic analysis allows for the prediction of illumin-
ance (lux), irradiance (W/m?) and Daylight Factor (%). i Geometry )
A typical node set-up is shown in figure 72. seemerv et
A VI Location (section 4.11.1) node, LiVi Geo-
metry (section 4.13.1) node, LiVi Context 4.13.2) node
and a LiVi Simulation (section 4.13.3) node are re-
quired for this type of analysis and the node connec-
tions should replicate the connections shown in figure ' contrtont O

 LiVi Simulation

| Frames:1-1

72. A basic LiVi analysis can be selected in the first
menu of the context node. ‘
If no sensing geometry is present only the “Pre-

view” button will appear in the LiVi Simulation node. o ditanc
Pressing the “Preview” button will open up a Radiance Sy ‘

. . Start day 1/1:
rvu window to preview the scene from the perspect- et 0
™ VI Location )
ive of the chosen Blender camera. A blender camera is T =
. . HDR: (B
therefore required in the scene. sl channels: 0

If sensing geometry is present then pressing the
"Calculate" button will run the Radiance simulation.
A Kivy window should then, assuming the simulation
takes enough time, appear giving an estimate of simu-
lation time and presenting a button to cancel the simulation. When completed the Radiance results are stored within
the meshes of the sensing geometry for visualisation. After simulation options in the "VI Display" panel detailed in

Figure 72: Typical LiVi Basic node set-up
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section 5.6.7 control visualisation of these results within the 3D viewport. The options within this panel are similar
to the ones available for shadow mapping (section 5.3).

a7 7
NERERRRRNNRET

ooNwhLINVO =ML
BoUNPULDOOW O 6

Figure 73: LiVi viewport Daylight Factor visualisation

A “VI results” socket is also exposed for connection to a VI Chart, VI Metrics and VI CSV node. VI Chart
visualisation works best with LiVI CBDM analyses (section 5.6.3), and VI Metrics node requires Daylight Factor
results, which are only generated if “DF sky” is selected in the “Sky type” option in the LiVi Context node. As-
suming this is the case the VI Metrics node, if switched to “Lighting”, will display RIBA 2030 and BREEAM
compliance. An info-graphic is available for RIBA 2030 (figure 74) by pressing the “Infographic” button, which
will open a new window with the graphic and a vector file called metric.svg will be created in the project directory.

RIBA 2030 Climate Challenge - Daylighting
DF IR

Average Daylight Factor llluminance Ratio

-

-

8.85 0.57

Sensor location: Plane

Figure 74: RIBA 2030 compliance info-graphic
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5.6.3 LiVvi CBDM

v LiVi Simulation
Vl results
Frames: 1-1

Photon map: O

Accuracy

v LiViGeometry W]
Geometry out @ yin
Triangulate: O + LiVi Context Foan % S
Mesh: O Context out ()
Animated: (] Parameter ()
Result p... @IiE:
Allyear: O
, Weekdays only: O
LEED v4: O
Start day 1/1: i
End day 31/12:
Start hour:
End hour:
!
(S)DA (Min):
UDI Low (Max):
UDI Supp. (Max):
UDI Auto. (Max): Tux 3000 | |
ASE level: lux 1000
< Vi Location © Source file:
Location out Resolution: I
Parameter o O
Source: (E v ( Export )

Weather file: GBR - BIRMINGHAM v 0 Location in

Figure 75: LiVi CBDM node setup

A Climate Based Daylight Modelling (CBDM) analysis requires the same node setup as a basic LiVi analysis, but
with the first option of the LiVi Context node set to “CBDM”. Some CBDM specific options are then revealed
in the context node (section 4.13.2). A CBDM analysis allows the lighting performance of a building over longer
periods of time to be analysed. The other difference is that an EPW file must be specified as the source of location
information in the VI Location node as the information for the environmental lighting conditions is provided (at
least initially) by this EPW file. There are three main types of analyses:

o Exposure - calculates the cumulative exposure of either illuminance (luxhour) or irradiance (kWh)

o Hourly irradiance - calculates the hourly irradiance (W/m?) at each sensor point, which is then aggregated
for a whole obtect to produce an hourly sum in kW, or an hourly average in kW/m? landing on an object.

o DA/UDI/SDA/ASE - calculates hourly metrics such as daylight availability (DA), annual sunlight exposure
(ASE), useful daylight illuminance (UDI).

o Glare - calculates glare occurance/autonomy as an annual summary with optional hourly figures.

When the simulation node’s calculate button has been pressed the Radiance simulation is initialised, a Kivy window
will appear and the Blender interface will lock up until completion. The simulation can however be cancelled from
the Kivy window. If an hourly calculation metric has been selected the simulation can take some time. Once
completed, display options will again appear in the VI Display sub-panel and detailed in section 5.6.7. A “Results
out” output socket is also exposed in the simulation node for connection to a visualisation node. If hourly data has
been generated, the VI Chart, VI Metrics and VI Heatmap node can be used for visualisation. The VI Metrics node
can be used to test for compliance against LEED v4 Option 1 daylighting criteria if a DA/UDI/SDA/ASE analysis
has been undertaken. Set the metrics node type to “Lighting” and the metric to “LEED”. An “Infographic” will also
be exposed to generate an infographic in a new window. This vector image is also saved to the project directory as
metric.svg. Figure 76 shows an example. The VI CSV node can be used for further results processing.
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Figure 77: LiVi viewport UDI visualisation

5.6.4 LiViImage creation

Radiance images can be generated with LiVi for
more contextual illuminance/brightness calculations
and glare analysis. To create a Radiance image, the
LiVi Geometry and LiVi Context nodes connect into
a LiVi Image (section 4.13.4) node instead of a LiVi
Simulation node.

Once the desired options have been set in the LiVi
Image node then pressing the “Image” button will be-
gin the calculation of the image and bring up a Kivy
window to show progress. As the simulation runs the
image will be updated and stored to the “liviimage” im-
age in Blender’s image editor. It should be noted that
the generation of high accuracy Radiance images can
take a long time.

Especially when simulating exterior scenes, the im-
age produced can be over-exposed and appear too white
in Blender. In this case the Compositor window in
Blender can be used to tonemap the image.

Once the simulation is finished then the images are
saved to the images folder in the project directory with
name(s) base_name-frame.hdr where base_name is set
in the image node and frame is the frame for which the
image is generated.

Radiance images can be de-noised by Blender quite
nicely (figure 78) and is detailed in this YouTube video
(https://www.youtube.com/watch?v=JdP9Tx9nPgI).

LEED v4 (Option 1) Daylighting Analysis

Sensor location: if_flooring_sensor
Floor area: 47.81m?

ASE >= 10%: Falil
(0 Points achievable)

Annual Sunlight Exposure (1000/250)

sDA < 55%: Fail
(0 Paints)

sDA < 75%: Fail
(0 Points)

Spatial Daylight Autonomy (300/50%)
Total points: 0 of 3

Figure 76: LEED v4 option 1 compliance info-graphic
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(a) Base image (b) De-noised image

Figure 78: Blender de-noising of Radiance images

5.6.5 LiVi Glare analysis

Instantaneous glare analysis is achieved with the LiVi Glare (section 4.13.5) node, and uses the evalglare program
included with Radiance. Glare analysis requires a fisheye Radiance image of a scene, and this image can be provided
by the LiVi Image node. To generate this image the fisheye option should be selected in the image node, 180° should
be set as the field-of-view (fov) and image pixels should be set to 800x800. Larger images can be processed but
it takes a long time. Once the image has been generated the image node can be plugged into the LiVi Glare node.
Appropriate options can then be set in the glare node, and the “Glare” button pressed to start the glare calculation.
The glare analysis image will be saved in the “images” folder of the project directory with the name base_name-
frame.hdr where base_name is set within the node, and frame is the frame the image is generated for. The image
will contain on the top right a list of glare parameter such as daylight glare probability (DGP). Refer to the evalglare
manual for information on these parameters.

Figure 79: LiVi glare analysis (red areas show high glare probability)
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5.6.6 LiVi False Colour

A LiVi image can be processed with a false colour filter to associate colours, via a legend, with the numerical data
embedded within the image. A false colour image is produced by connecting a LiVi Image node to a LiVi False
Colour node (section 4.13.6) or by using the file open dialogue to open an Radiance HDR formatted image. If the
image is generated with the LiVi image then seetings within that node define what king of data is embedded within
the image. If the “Illuminance” toggle is turned on then the image contains illuminance data in lux. If not then
the image contains luminance data in cd/m?. Once options in the LiVi False Colour node are set as desired, then
pressing the “Process” button will create a false colour image in the “images” folder of the project directory. The
name of this file will be base_name-frame.hdr where base_name is set within the node, and frame is the frame of
the simulation the original image is associated with.

Figure 80: LiVi falsecolour processing showing scene brightness

5.6.7 LiVi Display

After a LiVi basic or CBDM simulation, display options are presented within the VI Display panel of the VI-Suite
tab of Blender’s viewport sidebar (toggled with the "n" key over the 3D display). A typical, LiVi specific VI Display
panel is shown in figure 81 along with the Blender viewport and result/legend display.

@ VI Display E]
Result type: DF (%) ~ 3
DF (%) N Legend unit: : g
l 7.22 Processing: <
g;llg Modifier: :] g
— ?lg% Frame: E
:: %2% Legend max: %
1 %Sg Legend min: ;
I %gg Legend sc... Log v %
- %(2)99) Legend col... i
=i | § — wooN F
L[ ]ig Emitter materials: @] %
- 1%2 Draw wire: —
L1 888 1 Transpare...
= 8%% T ] ‘_h—r Point visualis. . ,-=-=-=memmmmeemn
= 822 - Enable: @]
B | —
l 858 R Display active

Figure 81: LiVi Display options
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Initially after simulation, only the "VI 3D display" toggle switch and the "Radiance Display" button are shown.
The "VI 3D display" toggle controls whether a 3D display of the results metric is desired. Once the "Radiance
Display" button is pressed new Blender objects will be created in the “LiVi Results” collection and coloured ac-
cording to the Radiance results., icons to display data graphics will appear in the 3D view and further options are
presented. If the colouration of the results geometry cannot be seen, and you are in Blender’s solid display mode,
you need to select material colour in the solid mode shading menu at the top of the 3D viewport. The options
presented include:

o Result type - sets the metric for display. Choices here will depend on the kind of analysis that has been
conducted.

<

<

<

A basic lux analysis will present entries for lux and visible irradiance (W/m?)

A basic analysis with a Daylight Factor sky will present entries for Daylight Factor (%) and visible
irradiance (W/m?)

A basic analysis with a Gendaylit based sky and with “Spectrum” set to “Full” will present entries for
full irradiance (W) and full irradiance per unit area (W/m?).

A CBDM exposure analysis will present entries for cumulative solar irradiance (kWh) and cumulative
solar irradiance per unit area (kWh/m?) if “Spectrum” was set to “Full” in the LiVi Context node. If
“Spectrum” was set to “Visible”, kilo-lux hours, cumulative visible irradiance (kWh) and cumulative
visible irradiance per unit area (kWh/m?) are available.

A CBDM hourly irradiance presents cumulative solar irradiance (kWh) and cumulative solar irradiance
per unit area (kWh/m?) are available.

A CBDM DA/UDI/ASE/SDA analysis will present DA, sDA, ASE, UDI (low, supplemental, autonom-
ous and high), lux (max, min and average) and perimeter area options.

An annual glare anlysis will present values for glare occurance (GO (%)) and glare autonomy (GA (%)).

o GA view - selects the view if an annual glare analysis has been conducted.

o Legend unit - string entry to replace the legend title unit.

o Processing - menu entry to define any modifiers to be applied to the results.

<

&

o

o

Modifier - uses the following string entry to modify the results

* string entry to act as a result modifier (*100 would multiply results by 100, /100 would divide by
100).

* this option in combination with the legend unit option can be used to display results that are not
embedded in the result geometry e.g. lux values can be extracted from Daylight Factor (%) by
placing *100 here.

Script - uses a script to modify the results

* File - Blender text editor script for custom result modification (see appendices)

Frame - frame selection to visualise a step in an animated/parametric simulation

Legend max/min - controls the range of the displayed legend and the associated sensor mesh colours in the

3D view.

o

o

o

o

<

Legend scale - legend and result display can be set to linear or logarithmic.
Legend colour - sets the colour map for the legend and sensor geometry.
Legend levels - sets the number of legend and mesh colouration sub-divisions.

Emitter materials - set the result colour materials to emitters (ignores shading in rendered mode)

Emitter strength - sets the brightness of the emitter materials
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o Draw wire - toggles the display of a wire-frame for the selected object. May need to be selected twice to turn
on the wire-frame.

o 3D Level - controls the level of 3D extrusion of the results geometry (only appears if VI 3D display option
was chosen)

o Transparency - set the transparency level of the result geometry

The Point visualisation section controls the display of numerical result values for each point of the sensing geometry.
Options in this section include:

o Enable - toggles numeric display
o Selected only - display numerical results only on the underlying selected mesh faces

o Visible only - only the sensing geometry points not behind other geometry display numerical values (orient-
ating the view to the selected object may be required to correctly calculate which points are visible)

o Font size, colour, shadow controls the number display

o Position offset - controls the offset point for the numerical display (in general should be set to the same value
as the offset value in the LiVi Geometry node

The "Display active" option at the bottom turns off result display. This should be turned off when results display is
no longer required.

5.7 EnVi Energy Analysis

~ VI Heatmap
(2 ) (ori 144 ]
((zone temporal ) (ENFROOM ] (Temperature (... ]
Days: ( 1 ) ( 365 |
Hours: ( 1 ] ( 24 )
Metric range:
Colour map:
~ EnVi Export v EnVi Simulation Contour lines: O
Context out «J) VI results Contour fill: ()
Shadow: (e 9 Results name: ( Create heatmap )
Animation: 0 Calculate T
Name/location: ) Context in « VI Chart
sl (Fmteromnce. ) | X range (start 1) (End 8760
Exposure: Chart type: (_Line/Scatter <) (Con 92 )
End day 31/12:
) Time-steps/hour O Xaxi (Zonet.. +) (ENFR.) (Heatin. ) (100 )
I EnVliGeemetry Results Category: W Yaxi...[1 +) (climate v] (wind Spee...] ([ 1.00 ]
S/t Temperature Humidity ?
ofset (o] 10 ] o Heating (O cooling
Darneing (Jreatrecovery S
. - ’ (D Air cooling (O solar gain Vi results
¥ ViLocation © (O Heat balance (O Equipment Type:
Location out € ( = ] -
Source: EPW Y] S e Frame
Heating efficiency:
Uneguitet
Carbon factor:
Tye
Space heating (kWh/m2): 29.7
Space cooling (kWh/m2): 0.0
Power production (kWh/m2): 0.0
Gross operational (kWh/m2): 35.0 (PASS kWh/m2 <= 60)
Net operational (kWh/m2): 35.0
© Viresuts

Figure 82: Typical EnVi node set-up with VI Chart, VI Heatmap and VI Metrics visualisation nodes
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Figure 85: EnVi material layer nodes

The EnVi component of the VI-Suite is a pre-processor for the EnergyPlus simulation engine (https://energyplus.net/).
When Blender mesh objects are specified as EnVi surfaces, have materials associated with them that contain En-
ergyPlus construction details, via EnVi material nodes, and are organised into Blender collections to represent
thermal zones, they can then be exported to EnergyPlus for analysis. EneryPlus only accepts planar geometry, so
zones can either be modelled in Blender with planar surfaces or with more complex geometry but with only the
mesh faces that would make up the planar geometry given EnVi construction characteristics. Here we will look at
a simple planar geometry case.

First save the Blender file, if not already saved, as this will define the
project directory. One can then proceed to create geometry with regular
Blender mesh objects, bearing in mind that +Y in Blender is North. The
image in figure 84 shows a simple planar model. Blender mesh objects -
that will define an EnergyPlus thermal zone must all be placed in the =
same Blender collection. In this example the Blender mesh object has ?
all the surfaces required for an EnergyPlus thermal zone so can go on
its own into a Blender collection. Both the collections and the objects
inside can be named for clarity. Here I will use “Studio” for the name of
the collection and Studio_model for the name of the object (figure 83).
Avoid spaces in the names of objects and collections. The object also
needs to be given the EnVi Surface designation in the VI-Suite Object
properties panel.

Next we need material specifications. Create and
apply Blender materials to the faces of the object’s
mesh. In this simple example I will create a “Walls”
material for the walls, “Roof” for the roof, “Floor” for
the floor and “Window” for the windows and associate
them with the relevant mesh faces. For each material
click the “Create EnVi Nodes” button in the VI-Suite
Material properties panel. This will create an EnVi Ma-
terial node tree associated with that material. Within
this node tree there will be a single EnVi Construc-
tion node. Within this node set the type of construc-
tion: “Walls”, “Floor” etc. as appropriate and choose
whether construction details will be pulled up from
the current database (pre-set specification), or whether Figure 84: Simple planar geometry model
layer nodes will be used to build a custom construction
(layer specification). If using pre-set, select the database entry and fill in the required layer thicknesses. If using
layers, add a material layer node (sections 4.16.2, 4.16.3 and 4.16.4) and connect it to the “Outside layer” input
socket of the EnVi Construction node. This will be the outermost material layer. Add subsequent layer nodes to
each previous layer node to build up the construction, working inwards towards the inner layer. EnergyPlus allows
up to 10 layers. Figure 85 shows a layered wall construction with the inner layer a custom defined.

7

B Scene Collection

> Collection 2 o o]

Studio © QA
Studio_model %/ lol @

Figure 83: EnVi collection organisation
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Once the materials have been specified, go to the VI-Suite Nodes window and create a new node tree with the
button in the middle of the header bar. Add a VI Location node (section 4.11.1) and set “Source” to EPW, then select
either one of the included weather locations or, if a custom EPW weather directory has been set in the VI-Suite
addon preferences, a user supplied one.

Add an EnVi Geometry (section 4.14.1) node and
set the offset option to move the exported geometry
away from the original for visibility. Press the “Ex-
port” button and a copy of the original geometry will
be created, offset by the set amount. The materials will
also be coloured according to the type of material con-
struction, assuming you are in Blender viewport solid
rendering mode. This helps identify any errors in ma-
terial allocation. If an error has been made, simply cor-
rect and re-export. The colours assigned are brown for
floor, green for roof, grey for walls, turquoise for win-
dows, yellow for party constructions, red for shading
surfaces and blue for PV panels. A new Blender collec-
tion will be created called “EnVi Geometry” and within
this collection will be collections that represent the thermal zones (figure 87) with “EN_” prepended to the original
collection names.

Once geometry export is complete, an EnVi Net-

Figure 86: Post export geometry (original on the left, off-
set copy on the right)

work node tree will be created and in this node tree will (=

be an EnVi AFN (section 4.15.1) node, and an EnVi [t= v] [ll_@v] [’O ] [7 v} E

Zone (section 4.15.3) node for each created collection. B Scene Collection

These nodes may also be created on top of each other » & Collection 2 © B

and will need to be moved around for visibility. v = cudi o0
It is important to check the volume of the zone be- . studio

ing reported in the EnVi Zone nodes, as the automatic | > Studio_model 1/ © @

calculation can be incorrect with non-manifold geo- v EnVi Geometry © @

metry. If it is wrong, .select “Manual” gnd enFer the v = EN_STUDIO o ©)

correct volume. In this example there is no airflow

network so the AFN node can be ignored. The EnVi > ENSTUDIO &, © @

HVAC, Occupancy, Infiltration and Equipment nodes

can now be used to define the heating, cooling, occu-
pancy, infiltration and equipment gains. The example
in figure 88 shows heating applied with a thermostat
level of 20°C and an occupancy level set with a sched-
ule of full occupancy of three people between 08:00 and 18:00 on weekdays and unoccupied at other times.

Once each zone has been given the desired characteristics, the EnergyPlus input file can be written with an EnVi
Context node (section 4.14.2) added within the VI-Suite Nodes tree. This node should be connected to both the VI
Location node and to the EnVi Geometry node. In this node some general characteristics of the project can be set,
and the results to be calculated chosen. In this case “Zone Thermal > Temperature”, “Zone Thermal > Heating”
and “Comfort > Occupancy” are selected.

Once the context has been exported, an EnergyPlus simulation can be conducted with an EnVi Simulation
(section 4.14.3) node attached to the EnVi Context node. During simulation a Kivy window will appear to monitor
progress or cancel the simulation. Upon completion, a VI CSV node can be connected to the simulation node to
export results to CSV, or if visualisation of the results is required, then a VI Heatmap, VI Chart, or VI Metrics node
can be connected to the simulation node (figure 82). A typical node layout is shown in figure 82.

It is also important for EnVi analysis to provide a database directory within the VI-Suite addon preferences
to store a custom database of EnergyPlus materials and constructions. The relevant database files are the Mater-
ial_database.json and Construction_database.json files respectively. If this directory is not set the user can still use
and edit the built-in databases but these will be overwritten when updating the VI-Suite.

Figure 87: EnVi Geometry collection

Dr Ryan Southall 76 School of Architecture, Technology & Engineering



VI-Suite v0.7

5 Using the VI-Suite

| v HVAC
\ EnVi AFN — HVAC
Heating -----------
WPC type: , v EnVi Zone (1]
| | Heating temp: °C 50.00
Build type: ‘ | Zone: EN_STUDIO
Thermostat level: °C 20.00
Max iter: | { Inside convection:
Init method: | { . Outside convection: | Default v
| | Cooling --------——
Rel Converge: 0.000 o Volume calc:
Abs Converge: 0.00000 | | X Auto volume: 163.6
Outdoor air -----------—-
Azimuth: (o 1 | HVAC
I O Schedule
Axis ratio: 1.00 O Hschedule Occupancy
® Azimuth array O CSchedule Eqiipment
o Infiltration
- TSPSchedule
v Occupanc
L < VASchedule
* EnVi Net Schedule © Occlbanc/ad
Schedule O) Type:
Source [ Node v] Max level:
End day 1: [ 365 ] Activity level: W/p 90
Fors: [ weekdays weekends ] Comfort calc: d
Untils: (08:00 0, 18:00 1, 24:00 0;24:00 0 | OSchedule
— ——— ASchedule
WSchedule
VSchedule
CSchedule

Figure 88: EnVi Zone specification

5.7.1 EnVi Embodied Carbon analysis

As well as energy analysis, EnVi can can conduct an embodied carbon analysis to deliver a whole-life carbon
(combining operational and embodied carbon) result that gives a better indication of the overall environmental
impact of a building.

The specification of the embodied carbon specification of building surfaces is done in the same way as the
specification of custom layer thermal properties: via the EnVi Material opaque and transparent layer nodes (section
4.16.3 & 4.16.2). Each of these nodes has an “Embodied” toggle which presents options to either read embodied
carbon data from the current database or for the input of embodied carbon data from a manufacturer’s Environmental
Performance Declaration (EPD) associated with their product. It is beyond the scope of this document to detail all
the features of embodied carbon counting and EPDs, but a manufacturer’s EPD will contain some key information
that EnVi needs for an embodied carbon analysis. The most important of which is global warming potential (GWP)
in kgCOqe, which EnVi uses as the embodied carbon metric. This GWP can cover a range of embodied carbon
modules which identify the various steps of in the lifetime of a material. The ICE database which comes with the
VI-Suite considers embodied carbon over the modules A1 to A3, which means from cradle to gate or from raw
material extraction to leaving the factory. Generally EPDs will always give a figure over A1 to A3. There are other
modules that cover transportation to building site, installation, maintenance and disposal and EPDs may or may
not give GWP figures for these modules. The user is free to use a GWP figures for any range of modules provided
by an EPD, and the modules covered can be added in to the EnVi nodes via a text box e.g. A1 - A3 or Al - A5, B1
- B2.

The next piece of important information in the EPD is the declared unit i.e. the unit of measure for the material
for which a GWP number is produced. Common units are kg, m?, m? or 1 of the product concerned e.g. the
embodied carbon value of a chair is generally per chair. This data can also be entered into the node. As well as the
declared unit there can be a declared amount i.e. how many of the declared unit is the GWP presented for. This is
often one but there are cases where it is more convenient to talk about, for example, the GWP for 2.5kg of material.
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An often required piece of information is density. EPD files give a density in kg/m3where appropriate, and this
can be useful as it can convert the volume based data of EnVi materials into a weight. This is especially important
if the declared unit is weight based e.g. kg.

The final piece of information needed from an EPD is the service life, or the life of the product in years before
on average it needs to be replaced.

In terms of Blender geometry, the nature of the embodied carbon data used has some consequences on how
things are modelled. When EnVi materials are created a thickness is specified and this material is applied over the
Blender mesh faces which constitute an area. This gives a volume. If the declared unit is m® then this is a simple
conversion. If the declared unit is m? then the thickness specification is ignored, although it is still used for the
thermal calculation. If the declared unit is kg, the density figure inputted is required to convert the volume to a kg
amount. If the declared unit is Unit then each Blender mesh face that has this material applied should be the same
area as would be represented by the product unit when installed in the facade.

There may be elements of the overall building that are not part of the layering of the facade but for which an
embodied carbon calculation is desired. An example of this may be a frame structure of the building, or some
internal fittings/furniture. As these elements are not be part of a conventional EnergyPlus thermal model, they can
be treated differently. In this case they can be represented in 3D and a process the same as that described in section
5.5 for a stand-alone embodied carbon analysis can be followed. As long as these objects are included in an EnVi
thermal zone Blender collection, results will be included in the final EnVi results.

5.7.2 EnVi EMS calculations

A basic node setup to use EnergyPlus’ EMS system is shown in figure 89.

The EnergyPlus zone we are controlling is the EN_LIVING_ROOM zone. The sensor within that zone is COo,
so CO» should be calculated for that zone. The actuator is set to “Opening factor” which will control the opening
factor or any windows and doors in the zone. These two selections create named actuator and sensor sockets in
the “EMS Zone” node that must be connected to the EMS Program node to be registered within EnVi. The socket
names should replicated exactly in the program text detailed below.

¥ EMS Zone =)
Zone: | EN_LIVINGROOM  v|
N Sensor [ Zone CO2 V]
¥ Envi Program
- E Actuator [ Opening factor V}
Sensor
EN_LIVING ROOM_CO2
Actuator .
win_EN_LIVING ROOM_5_of
File: [E EMS_prog X win_EN_LIVING ROOM_6_of

Figure 89: EnVi EMS node setup

An example Blender text file contents to control the node parameters setup is shown in code listing 1. The
contents should be pretty clear: If the internal CO2 within the EN_LIVING_ROOM zone is above 1000 the open-
ing factors of the win_EN_LIVING_ROOM_5 and win_EN_LIVING_ROOM_6 is set to 1. If not the windows
opening factors are set to closed. The syntax of this text should follow that laid down in the EnergyPlus EMS
documentation with the exception that the semi-colons at the end of each line are not required.

IF EN_LIVING_ROOM_CO2 > 1000
SET win_EN_LIVING_ROOM_5 of = 1
SET win_EN_LIVING_ROOM_6_of = 1
ELSE
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SET win_EN_LIVING_ROOM_5_of = 0
SET win_EN_LIVING_ROOM_6_of =
ENDIF

|
o

Listing 1: Example ERL program listing

5.7.3 EnVi Display

3D viewport display of EnVi results is not currently supported in version 0.7.

5.7.4 Storing EnVi custom constructions and materials

In general it is recommended that custom materials are added to the builtin database via the buttons in the “EnVi
Construction” (section 4.16.1) and “EnVi Layer” nodes. Be aware that unless a custom database directory is set
within the VI-Suite addon settings, this database is overwritten if updating the VI-Suite.

It is however possible to edit the databases directly. Within the VI-Suite add-on preferences database directory
are a number of json formatted files. EnVi constructions are stored in “Construction_database.json” and materials
in the “Material_database.json” file. Before changing either of these files it is a good idea to make a back-up copy.
If editing this file then adding a new material will require adding a material name and a list of properties to the
correct material class. For example adding the entry below to the “Metal” class would add a “Lead” material.

”Lead”: [”Smooth”, ”35.3”, ”11340”, ”128.00”, ”0.05”, ”0.05”, ”0.05”, ”5”]

The first word is the name of the material, the first word within brackets is the surface roughness, and the
following numbers are thermal conductivity (W/m-K), density (kg/m?), specific heat (J/kg-K), thermal absorbtance,
solar absorbtance, visible absorptance, default thickness (mm).

A material added to the “Glass” class may look like

”Clear 6mm”: [” Glazing”, ”SpectralAverage”, ””, 70.006”, 70.775”, ”0.071”,
”0.071”, 70.881”, ~0.080”, »0.080”, ”0.0”, 70.84”, 70.84”, 70.97]

The numbers within the brackets specify default thickness (m), solar transmittance at normal incidence, front
side solar reflectance at normal incidence, back side solar reflectance at normal incidence, visible transmittance
at normal incidence, front side visible reflectance at normal incidence, back side visible reflectance at normal
incidence, IR transmittance at normal incidence, front side IR hemispherical emissivity, back side IR hemispherical
emissivity and thermal conductivity (W/m-K).

Any entry added to the json files should be comma separated from the existing entries in that class.

5.8 FloVi Flow Analysis

FloVi employs Netgen (https://ngsolve.org/) for mesh generation and OpenFOAM (https://openfoam.org/) for sim-
ulation of fluid flows. On Linux, a native OpenFOAM installation is required. This can generally be installed
through the system’s package manager. Once installed, use the “OpenFOAM bin” option in the VI-Suite ad-
don preferences to point the VI-Suite to the “bin” directory within the OpenFoam installation that contains the
“foamExec” executable. Save the settings and then restart Blender.

On Windows and OS X, setting the “OpenFOAM bin” option is not necessary but an installation of Docker
Desktop (https://www.docker.com/products/docker-desktop/) is required, and within this the dicehub/openfoam:10
OpenFOAM image should be installed. Docker must then be running in the background while conducting FloVi
analyses.

The sections below detail the steps that should be taken, in order, to undertake a flow analysis.

5.8.1 Generating an OpenFOAM case directory

As all CFD analyses require an overall computational domain, the Blender scene must contain one and only one
object defined with the “CFD Domain” property in the VI-Suite Object properties panel and visible within the 3D
viewport. This is the domain that will encompass the entire fluid simulation. This object can be any shape.
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In addition, objects can sit within the fluid domain to act as obstructions to the fluid flow. These geometries
must sit fully and separately within the overall domain as overlapping geometries are not supported. To identify
these objects as obstructions select “CFD Geometry” in the VI-Suite Object properties panel. Again, these objects
can be any shape.

Finally, empties and mesh objects can be created to act as probes within the domain. These should be positioned
inside the domain, and outside any obstructions, and identified as a probe by selecting ’CFD Probe’ in the VI-Suite
Object properties panel.

It is important that all domain and obstruction geometry is manifold i.e. a completely sealed and coherent
volume. There is a tool in Blender “Select non-manifold” to highlight object geometry that is non-manifold for
corrective purposes.

The domain and obstructions must also have Blender materials associated with each face, as it is with these
materials that we will designate the boundary conditions for the fluid flow simulation. To begin, simply create and
apply a different Blender material to every face of the domain, and any internal geometry, that will have a distinct
boundary condition e.g. a material for solid surfaces, inlets, outlets, symmetries etc.

Once geometry has been created, and materials applied, then in a VI-Suite Nodes window create a FloVi Case
node from the “Add” menu. Details of this node can be found in section 4.17.1. In this node the type of simulation,
initial field conditions and whether heat (buoyancy) and radiation should be simulated can be specified.

The important parameter in this node is the scenario setting, as this will define what kind of boundary conditions
are available for the materials applied to the geometry.

Upon clicking the “export” button at the bottom of the case node an OpenFOAM case folder is created within
the OpenFOAM directory of the project directory. The case directories are named after the name of the frame(s)
being simulated e.g. if a parametric simulation over frames 1 to 3 is exported the case directories ’1’, ’2’ and ’3’
will be created in the project directory/OpenFOAM directory.

5.8.2 Specifying OpenFOAM boundary conditions

After a FloVi case has been generated, general boundary conditions for the material associated with the mesh
geometry can be specified. These specifications are still made in the material properties panel of the relevant
material but the details of this specification have changed since v0.6.

Now the boundary condition options provided are filtered by the scenario chosen in the FloVi case node. Five
scenarios are offered:

o External flow - predominantly for wind flow around buildings.

o Internal flow - predominantly for forced ventilation inside buildings.

o Forced convection - predominantly for forced ventilation inside buildings with temperature calculation.
o Free convection - predominantly for buoyancy driven natural ventilation inside buildings.

o Custom - all boundary conditions available in the VI-Suite are available to the user and the context of the
simulation is up to the user.

At this stage it is only necessary to pick the desired boundary type e.g. if an external flow case has been selected
then the material associated with the mesh face where wind will leave the domain is set to Outlet. Boundary types
for the different scenarios are listed below:

o External flow

¢ Outlet - where the wind will leave

¢ Inlet - where wind will enter

¢ Sky - symmetry boundary

¢ Solid - solid wall boundary (ground/buildings)

o Internal flow

< Inlet - place where air will come in
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¢ Outlet - place where air will go out

¢ Solid - solid wall boundary

o Forced Convection

Velocity in - place where air comes in with a set velocity

Pressure in - place where air comes in with a set pressure

Pressure out - place where air leaves with a set pressure

o
S
¢ Velocity out - place where air leaves with a set velocity
S
o

Solid - solid wall boundary

o Free Convection

¢ Inlet - place where air is expected to come in

¢ Outlet - place where air is expected to go out

¢ Solid - solid wall boundary

o Custom scenario

¢ All available boundaries - refer to OpenFOAM documentation for their meaning.

If the context option in the case node is changed and the case re-exported, it is important to re-check the general

boundary condition specification for each material.

5.8.3 Generating an OpenFOAM mesh

The VI-Suite uses Netgen (https://ngsolve.org/) to cre-
ate a tetrahedral domain mesh with the “FloVi Netgen”
node (section 4.17.2). This can then be optionally con-
verted into polygonal domain mesh with OpenFOAM.
The “Case in” socket of this node should be connected
to the “Case out” of a FloVi Case node.

Options within this node, control the internal mesh
maximum cell size and some advanced meshing para-
meters. Clicking the “Generate” button at the bottom of
the node generates a tetrahedral mesh. If OpenFOAM
is available on your system then a polyhedral mesh can
be generated instead with the node’s Polygonal option.
The resulting mesh will be displayed in Blender via an
object called “Mesh” created in the “FloVi Mesh” col-
lection. If there are any errors in mesh generation, an
error message will be added to the “vi-suite-log” file in
Blender’s text editor. After mesh generation, re-export
the FloVi case to register the mesh.

Options for visualising the mesh in Blender are lim-
ited but a simple visualisation of the mesh can be con-
ducted. One simple method is to alter Blender’s view-
port starting clip plane. This will hide geometry closer
to the camera than the clip distance allowing a view in-
side the mesh. If you want to see the mesh distribution
on a boundary enter edit mode on the mesh and deselect

Figure 90: Polygonal mesh visualisation on a solid
boundary

all elements by pressing “Alt a”. Go to the Material Properties panel and beneath the list of material associated
with the mesh you will see a select button. With the boundary material you wish to visualise selected press this
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select button and then press “Crtl i” to invert this selection. Pressing “h” will now hide all mesh elements that do
not have that material. An example is shown in figure 90. Pressing “Alt h” will unhide everything again.

More extensive mesh visualisation options are available with Paraview (https://www.paraview.org/). After mesh
creation, a frame.foam file is created within the project directory/OpenFOAM/frame directory, where frame is the
Blender frame being simulated. This foam file can be opened directly with Paraview.

5.8.4 Generating OpenFOAM boundaries

Once the mesh has been generated, the detailed characteristics of the mesh boundary conditions can now be written
into the case directory. This is done with the FloVi Bound node (section 4.17.3), the “Mesh in” input socket of which
should be connected to the “Mesh out” socket of the FloVi Netgen node. This node is useful to make changes to
the detailed boundary characteristic without having to generate a new mesh. An exception to this is if you want
to change the general boundary class e.g. from “Inlet” to “Solid”. This will require a new case export and a new
mesh generation.

For example, if ’External flow’ was selected as the scenario in the “FloVi Case” node then the following bound-
ary conditions are offered:

o Outlet

pressure - totalPressure and fixedValue OpenFOAM boundaries are offered

U - pressurelnletOutletVelocity OpenFOAM boundary is offered

k - inletOutlet OpenFOAM boundary is offered

o
o

¢ nut - calculated OpenFOAM boundary is offered

o

o epsilon - inletOut OpenFOAM boundary is offered

o Inlet

pressure - zeroGradient OpenFOAM boundary is offered
U - fixedValue and atmBoundaryLayerInletVelocity OpenFOAM boundaries are offered

k - fixedValue OpenFOAM is offered

S
o

© nut - calculated OpenFOAM boundary is offered

S

o epsilon - FixedValue OpenFOAM boundary is offered

o Solid

pressure - zeroGradient OpenFOAM boundary is offered

U - noSlip OpenFOAM boundary is offered

nut - nutlWallFunction OpenFOAM boundary is offered

k - kgqRWallFunction OpenFOAM boundary is offered

epsilon - epsilonWallFunction OpenFOAM boundary is offered

S0 0 00

o Sky

¢ a symmetry boundary and is generally used for the top of the domain or side faces parallel to the flow
direction.

Choosing an “Internal flow” case presents similar boundary conditions:
o Inlet

¢ pressure - zeroGradient boundary is available
¢ U - fixedValue boundary is available

¢ nut - calculated boundary is avaialble
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¢ k - fixedValue boundary is available

o epsilon - fixedValue boundary is available
o Outlet

pressure - fixedValue and totalPressure boundaries are available
U - pressurelnletOutletVelocity boundary is available

o
o

¢ nut - calculated boundary is avaialble
¢ k - inletOutlet boundary is available
S

epsilon - inletOutlet boundary is available
o Solid

o pressure - zeroGradient OpenFOAM boundary is offered

¢ U - noSlip OpenFOAM boundary is offered

o nut - nutlWallFunction OpenFOAM boundary is offered

¢ k - kqRWallFunction OpenFOAM boundary is offered

o epsilon - epsilonWallFunction OpenFOAM boundary is offered

Choosing an “Forced convection” case presents the following boundary classes:
o Velocity in (to be used in combination with a Pressure out boundary for outgoing flow

pressure - calculated boundary is available

U - fixedValaue boundary is available

nut - calculated boundary is available

k - turbulentIntensityKineticEnergyInlet boundary is available
epsilon - turbulentMixingLengthDissipationRateInlet

T - fixedValue is available

p_rgh - fixedFluxPressure is available

alphat - calculated boundary is available

[ B R SR SRR B e e R R

Rad - MarshakRadiation and zeroGradient boundaries are available
o Velocity out - to be used in combination with a Pressure in boundary for incoming flow

pressure - calculated boundary is available
U - fixedValue boundary is available

nut - calculated boundary is available

k - zeroGradient boundary is available
epsilon - zeroGradient boundary is available
T - zeroGradient boundary is available
p_rgh - zeroGradient boundary is available

alphat - calculated boundary is available

[ R - R R I e R R R ]

Rad - MarshakRadiation and zeroGradient boundaries are available
o Pressure in - to be used in combination with a Velocity out boundary for outgoing flow

¢ pressure - calculated boundary is available

¢ U - pressurelnletOutletVelocity boundary is available
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nut - calculated boundary is available

k - turbulentIntensityKineticEnergyInlet boundary is available
epsilon - turbulentMixingLengthDissipationRateInlet

T - fixedValue is available

p_rgh - totalPressure is available

alphat - calculated boundary is available

[ R SR e IR R R

Rad - MarshakRadiation and zeroGradient boundaries are available
o Pressure out - to be used in combination with a Velocity in boundary for incoming flow

pressure - calculated boundary is available
U - inletOutlet boundary is available

nut - calculated boundary is available

k - inletOutlet boundary is available
epsilon - inletOutlet boundary is available
T - zeroGradient boundary is available
p_rgh - prghPressure boundary is available

alphat - calculated boundary is available

L I R IR - IR R e R

Rad - MarshakRadiation and zeroGradient boundaries are available
o Solid

pressure - calculated boundary is available

U - noSlip boundary is available

nut - nutkWallFunction OpenFOAM boundary is available

k - kgqRWallFunction OpenFOAM boundary is available

epsilon - epsilonWallFunction OpenFOAM boundary is available
T - zeroGradient boundary is available

p_rgh - fixedFluxPressure boundary is available

alphat - compressible::alphatJayatillekeWallFunction boundary is available

L I R IR R B e R

Rad - MarshakRadiation boundary is available
Choosing a “Free convection” case presents the following boundary classes:
o Inlet

pressure - calculated boundary is available

U - pressurelnletOutletVelocity boundary is available
nut - calculated boundary is available

k - inletOutlet boundary is available

epsilon - inletOutlet boundary is available

T - inletOutlet boundary is available

p_rgh - totalPressure boundary is available

alphat - inletOutlet boundary is available

LR R A > IR - IR HE e R e

Rad - MarshakRadiation and zeroGradient boundaries are available

o Outlet
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pressure - calculated boundary is available
U - inletOutlet boundary is available

nut - calculated boundary is available

k - inletOutlet boundary is available
epsilon - inletOutlet boundary is available
T - inletOutlet boundary is available
p_rgh - inletOutlet boundary is available
alphat - inletOutlet boundary is available

L R R SR * IR - IR CEE * I O R o

Rad - MarshakRadiation and zeroGradient boundaries are available
o Solid

pressure - calculated boundary is available

U - noSlip boundary is available

nut - nutkWallFunction OpenFOAM boundary is available

k - kgRWallFunction OpenFOAM boundary is available

epsilon - epsilonWallFunction OpenFOAM boundary is available
T - zeroGradient boundary is available

p_rgh - fixedFluxPressure boundary is available

alphat - compressible::alphatJayatillekeWallFunction boundary is available

LB IR SR IR IR CEE * I O IR

Rad - MarshakRadiation boundary is available

Choosing a “Custom” case exposes all boundary conditions available in the VI-Suite and is for users with knowledge
of OpenFOAM and appropriate boundary conditions for a simulation.

Pressing the “Generate” button will create the boundary conditions according to the parameters set for the mesh
materials.

5.8.5 Simulating an OpenFOAM case

A FloVi Simulation node is required to conduct an
OpenFOAM simulation, the “Context in” input socket
of which should be connected to the “Context output”
socket of the “FloVi Boundary” node. Pressing the
“Calculate” button will initiate the simulation and a
Kivy window will appear (figure 91) to monitor the
progress of the simulation by showing the timestep and
result residuals. A new Kivy window will appear for
each frame of the simulation. The “Cancel” button at
the bottom of the Kivy window can be used to cancel

the simulation. Cancel
After calculation, Paraview (https://www.para-
view.org/) can be used to visualise results of the sim- Figure 91: FloVi Kivy window

ulation. On all platforms a frame.foam (where frame
is the frame number) file is created within every project directory/OpenFOAM/frame directory. This file can be
opened directly in Paraview. In addition, on linux the Paraview option can be turned on within the node to automat-
ically open Paraview open completion of the simulation. Probe results are also written to the “Results out” socket
for export to CSV with the VI CSV node, graphing with the “VI Chart” node or summarising with the “VI Metrics”
node.

A complete node set-up is shown in figure 92.
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Figure 92: FloVi node setup

5.8.6 Visualising OpenFOAM results

Most of the visualisation of OpenFOAM results is conducted with Paraview (https://www.paraview.org/). It is
beyond the scope of this document to detail a Paraview workflow, but it is possible to import back into Blender the
results of Paraview visualisations. By exporting the selected visualisation geometry with the “File > Export Scene”
menu in Paraview, and selecting the *.gltf format. This *.gltf file can then be imported into Blender with the “File
> Import > gITF 2.0” menu entry (the gITF import addon may have to be activated first). The imported geometry
may have to be rotated 90° on the x-axis to line up with the original FloVi geometry.

It is also possible to use another Blender add-on for the visualisation of OpenFOAM results: BVTKNodes
(https://github.com/tkeskita/BVtkNodes). Although not production ready, BVTKNodes can visualise OpenFOAM
domain slices, streamlines and glyphs from within Blender and is under active development so will get better over
time.

The VI-Suite also offers limited native visualisation of OpenFOAM results. The FloVi Simulation node can
be connected to a VI Metrics node or a VI Chart node. Both will visualise the results at probes specified within
the domain: VI Chart will produce charts of variables over the simulation time steps, and the VI Metrics node will
display the final results at the probe locations. A VI CSV node can be used to export probe values out to CSV file.

6 Known issues

o If using the potable zip version of Blender on linux, Netgen will not work. Either proceed without FloVi
functionality or install Blender, PyQt6, matplotlib, Kivy and Netgen with your system’s package manager.

o If a VI Display is running when a different Blender file is loaded this can cause an error.

o If doing a parametric analysis over more than 70 frames the “VI-Chart” may seg fault Blender. Use the “VI
CSV” node to output a csv file and plot from there instead.

o If maximising an area window while the VI-Suite is displaying results in the 3D viewport an error will occur
and “internal error: modal gizmo-map handler has invalid area” will be printed to the system terminal. You
will then need to deactivate the VI display and then reactivate. This is a known Blender bug and you can
register your interest in getting it fixed at https://developer.blender.org/T77419.

o If using shape keys to animate an object for a LiVi analysis then these shape keys will be lost if a sensing
surface is also part of the object.
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o

o

On OS X the Kivy window does not appear in front of the Blender window. Check the desktop for this
window when running a simulation.

If switching between analysis types it is recommended that the complete export process is repeated for the
new analysis.
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Additional installation notes

On Arch linux an installation of libxcrypt-compat is required. If the VI-Suite activation gives an error in the terminal
about a missing libcrypt.so.1, install this package.

Additional FloVi results extraction

By default, FloVo only records volume flow rate through mesh objects specified as FloVi probes. The example
sampleDict file below, which should be placed in the “system” folder of the case directory, enables the p and U
sampling of stl surfaces. The stl file names in the file should point should correspond to stl files in the “con-
stant/triSurface” directory in the case directory.

[————m————— *—- C++ ————"—""—"—"—"—""—————— - *\
| ========= | |
[\ / F ield | OpenFOAM: The Open Source CFD Toolbox |
[ W\ / O peration | Version: 2.1.0 |
| W/ A nd | Web: www . OpenFOAM. org |
| \\/ M anipulation | |
\g—————— -~ */
FoamFile
{

version 2.0;

format ascii;

class dictionary;

object sampleDict;
}
[] % s, s sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk k sk sk sk sk sk sk sk k k k sk sk sk sk sk *k *k //
type surfaces;

surfaceFormat raw;
interpolationScheme cell;
// Fields to sample.

fields
(
p
U
)
surfaces
(
stl_name_1
{
// Sampling on triSurface
type triSurfaceMesh;
surface stl_name_1.stl;
source cells;
interpolate true;
}
stl_name_2
{
// Sampling on triSurface
type triSurfaceMesh;
surface stl_name_2.stl;
source cells; // sample cells or boundaryFaces
interpolate true;
}

);
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Custom Data Processing

For types of analyses that project results on to Blender meshes such as lighting metrics, shadow study and SVF
calculations it is possible to manipulate the results for presentation. There are two types of manipulation: simple
modifier and scripted manipulations. These options are controlled via the ’Processing’ menu in the VI-Suite Display
panel. Options in this menu are: ’None’, Modifier’, and ’Script’. If Modifier’ is selected a text box will appear
where a valid Python expression can be entered e.g. /2 to divide all results by 2; *7 could be entered to multiply all
results by 7; *2+9 could be entered to multiply by 2 and add 9 etc.

An example of the use of this would be to convert shadow study data into the number of sunlit hours. When a
shadow study calculation is conducted the number of total hours, and the number of hours that the sun was above
the horizon, is displayed in the VI-Suite log file. Shadow study results are by default the proportion of hours when
the sun was above the horizon that a point received direct sunshine. To display instead the number of total sunlit
hours, enter *X into the text box where X is the total number of hours when the sun was above the horizon. If
the proportion of the total hours that points were sunlit is desired then *X/Y could be entered where Y is the total
number of hours.

If ’Script’ is selected in the *Processing’ menu, a drop-down menu will appear to select a Blender text file.
This file should be opened or created in Blender’s text editor. This text file should define functions in Python
that manipulate the results: a ’resmod’ function, and/or change the legend text entries: a ’restext’ function. This
is advanced functionality and some knowledge of Python programming is recommended as this file must contain
valid Python code.

The ’resmod’ function takes a list of results (defined by the “Result type” option) from each of the visualisation
meshes, and returns a modified list of the same length and in the same order. The numbers returned should be
integers and point to results material associated with the object: 0 would point to the first material (lowest numerical
band), 5 would point to the 6th material. It is therefore important that no number is returned that is higher than the
number of Legend Levels set minus 1.

The ’restext’ function returns a list of strings to be written into the legend that must have a length one less than
the number of Legend Levels set in the VI-Suite display tab. Although the scripting method is very flexible it is
especially good at visualising conditional results i.e. manipulating results based on user-specified criteria. A simple
example with comments is shown in code listing 2.

# Import the main Blender Python library
import bpy

# Define the resmod function that takes a list of original results
def resmod(reslist):

# reslist is a numpy array so we need to import numpy

import numpy

# Find the average of the reslists

ave_r = numpy.average(reslists)

# Create a new empty results list

newreslist = []

# Iterate thought the original results
for r in reslist:
# Set a conditional statement (uniformity ratio >= to 0.4)
if r/ave_r >= 0.4:
# Add an index to the new results list for this condition
newreslist.append (1)

# Set a conditional statement (uniformity less than 0.4)
else:
# Add an index to the new results list for this condition
newreslist.append (0)
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# Return the new results list
return newreslist

def restext():
# Return a list of strings for the legend. Lowest value first.
# The length of this list must be one less than the Legend Levels
setting
return [70.4”7]

# This registers the functions within Blender’s driver namespace
bpy.app.driver_namespace[’resmod’] = resmod
bpy.app.driver_namespace[’restext’] = restext

Listing 2: Example results processing script

The above code listing would result in the following visualisation of illuminance uniformity ratio, as required
by the RIBA 2030 Climate Challenge.
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Figure 93: Custom data visualisation of uniformity ratio
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